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Chapter 1 
 

Installation 

If you purchased a GenePix" 4000, 4100 or 4200 series scanner, you may have 

already installed GenePix Pro 6.0 following the scanner installation instructions.  

However, if you purchased the standalone GenePix Pro software, please use the 

following installation instructions.  

Computer Requirements 
GenePix Pro is fully functional with the Minimum computer requirements.  

However, satisfactory performance depends on the size of the files you will 

generate.  The RAM and hard disk configuration is the most critical.  If you plan to 

scan areas smaller than a full slide, or to scan regularly at 10-µm resolution, the 

Minimum requirements will provide satisfactory performance of all GenePix Pro 

features.  However, if you plan to scan full slides at 5 µm, or if you plan to run 

other applications simultaneously, we strongly suggest the Recommended 

configuration. 
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Computer—Minimum 

!# IBM-compatible computer with a 1 GHz Pentium or faster  

!# Windows 2000 or XP operating system  

!# Memory requirements:  

!# Full-size scan region at 5-µm resolution: 

1 GB RAM for two colors; 2 GB for three or more colors  

!# 10-µm scanning or partial-size scan regions at 5-µm resolution: 

512 MB RAM for two colors; 768 MB for three or more colors  

!# 40 GB hard drive (for image storage)  

!# Available full-size PCI slot for SCSI adapter (Note:  the provided PCI 

SCSI adapter will not fit in a low-profile or slimline case)  

!# CD-ROM drive  

!# 1024 × 768 display system with 65K colors  

!# Internet Explorer 6.0 or higher  

Computer—Recommended 

!# IBM-compatible computer with a 2 GHz Pentium or faster  

!# Windows 2000 or XP operating system  

!# 2 GB RAM  

!# 80 GB hard drive (for image storage)  

!# Available full-size PCI slot for SCSI adapter (Note:  the provided PCI 

SCSI adapter will not fit in a low-profile or slimline case)  

!# DVD-RW drive  

!# 1280 × 1024 display system with 16M colors  

!# Internet Explorer 6.0 SP1  
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Installation of GenePix Pro 6.0 
GenePix Pro 6.0 is on the included CD-ROM.  Insert the CD-ROM into your 

computer and the installation program “Welcome To The GenePix Pro Installation 

CD” automatically starts.  This gives you a number of options: 

!# Install GenePix Pro 6.0 

Click this button to launch the GenePix Pro 6.0 installer. 

!# Install pdfFactory  

pdfFactory is a third-party printer driver that enables you to print any 

document in any application as an Adobe Acrobat PDF file.  Use it in 

GenePix Pro to archive quality control reports, for example. 

!# Install Examples Images 

The CD contains some sample array images. 

If the installation program does not start automatically, perhaps because you have 

the autorun feature of Windows disabled, you can manually start the installation by 

running the Setup.exe program file on the CD-ROM as follows: 

From the Start menu select “Run”, and type x:\GenePix\setup.exe where “x” is the 

drive letter of your CD-ROM drive. 

On Windows NT, 2000 and XP, you have to be an Administrator or Power User to 

install GenePix Pro. 

Connecting the Hardware Protection Key (Dongle) 
GenePix Pro requires a security key to operate.  If the key is absent you can open 

images in GenePix Pro, but you cannot save your settings files or save your analysis 

results.  In addition, you can analyze only 1000 features.   
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Installation of the single-user license key is straightforward.  Simply connect it to 

the parallel port of your computer (or if it is a USB key, to a USB port).  If you 

have a printer already connected to your parallel port, you can still use the key as it 

is a “pass-through” device:  connect the key to the parallel port and then connect 

your printer to the key. 

GenePix Pro Network Key 

If you have purchased a multi-user license for GenePix Pro, you will be provided 

with a network key, which you need to install to access the full functionality of the 

software.  The GenePix Pro network key is a single USB device that provides 

security authorization for multiple sites, avoiding the inconvenience of having to 

install individual security key devices for each computer on the network.  The 

installation of a network key is quite straightforward, however it is a slightly more 

lengthy process than for the single-user license key, and the details are contained in 

Appendix A:  Installing A Network Key. 

Starting GenePix Pro 6.0 
The GenePix Pro 6.0 installation creates an “Axon Laboratory / GenePix Pro” 

folder in your list of Programs in the Windows Start menu, containing a variety of 

GenePix Pro program icons.  There are “GenePix Pro”, and “GenePix Pro (Analysis 

Only)” entries in your Axon Laboratory group, and a shortcut icon to GenePix Pro 

on your desktop.  Both the “GenePix Pro” and “GenePix Pro (Analysis Only)” 

icons will start GenePix Pro.  The only difference between the two is that the 

‘Analysis Only’ version does not interact with the scanner hardware in any way.  

All the image and data analysis functionality is fully usable in both versions.  If you 

are only analyzing data and are not doing any image acquisition, you would 

typically use the Analysis Only version, as the instrument is inactive in this mode 

and laser lifetime will be extended.  For acquisition, select “GenePix Pro”.  The 

“Axon Laboratory” folder also contains shortcuts to Uninstall, Help, Restore to 

Factory Defaults, Tutorial and GenePix Scanner Utilities. 
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Troubleshooting Installation 
If you are having problems running the software, please consider the following: 

!# GenePix Pro 6.0 requires a minimum of 512 MB of RAM to acquire 

images.  GenePix Pro is capable of analyzing data when less than 512 MB 

of RAM is present, but the maximum image size is reduced and 

performance will be non-optimal. 

!# GenePix Pro 6.0 requires a security key to save results or settings files, and 

to analyze images.  If the key is not found, the software operates with 

limited analysis and file-saving functionality.   
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Chapter 2 
 

Introduction 

GenePix Pro 6.0 from Axon Instruments / Molecular Devices Corp., is a fully 

featured array acquisition and first-pass analysis software package.  Its advanced 

imaging and data manipulation capabilities make GenePix Pro the software of 

choice for many of the leaders in array technology. 

GenePix Pro 6.0 Features 

Imaging 

!# Controls more than one GenePix scanner from the same computer; 

!# Calibrates and matches signal output from one or more scanners; 

!# Incorporates precise software control of the scan conditions and scan area, 

reducing scan time and image storage requirements; 

!# Acquires images from any GenePix scanner and a displays a ratio image in 

real time; 

!# Automatically sets PMT gain; 

!# Displays and analyzes up to four wavelength images and three ratio images; 

!# Constructs user-configurable pseudocolor intensity and ratio images for the 

easy visualization of activity levels;  
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!# Aligns and analyzes images from third-party scanners. 

Analysis 

!# Automatically constructs resizable arrays of blocks and feature-indicators 

for identifying and analyzing individual features on a slide; 

!# Performs Batch Analysis of an unlimited number of microarray images; 

!# Automatically aligns circular, square or irregular feature-indicators with 

features; 

!# Automatically reads a variety of barcode types on array slides; 

!# Automatically associates individual array features with substance names 

and IDs;  

!# Allows multiple flagging of features as measures of individual feature 

quality, by fully general Boolean queries; 

!# Automatically calculates and subtracts background effects with a choice of 

algorithms, such as local, global, negative control and morphological 

methods; 

!# Includes two instant data viewers, one for instant zoom views and primary 

data previews (the Feature Viewer), and one that graphs pixel intensity 

distributions for individual features and includes more advanced data 

preview (the Pixel Plot); 

!# Includes measurement tools for detailed analysis of specific image regions; 

!# Includes advanced control of data and image normalization; 

!# Is fully integrated with web-based genomics databases; 

!# Presents the extracted data in a spreadsheet for rapid sorting; 

!# Draws Scatter Plots of any extracted data measurements for all the features 

on an array;  

!# Applies user-defined threshold boundary lines to Scatter Plot data; 
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!# Exports intensity, ratio and quality measure data for analysis with advanced 

information systems;  

!# Is fully configurable on a per-user basis in multi-user environments; 

!# Automatically logs all experimental procedures and protocols in an 

electronic Lab Book; 

!# Includes full scripting support in VBScript and JavaScript for all 

acquisition and analysis functions; 

!# Is backed by unlimited technical support.
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Chapter 3 
 

 Software Principles 

GenePix Pro has been designed so that a user can acquire and analyze images of 

arrays without having to learn the finer details of image processing.  While you can 

use a GenePix series scanner and GenePix Pro to acquire and analyze images 

without any training at all, understanding the concepts and algorithms used in 

GenePix Pro is invaluable for interpreting the acquired data.  This chapter 

introduces the fundamental principles underlying the GenePix Pro software.  In 

addition to this chapter, the Chapter 4 Tutorial provides information on some of the 

basic operations and terminology used in GenePix Pro. 

Although GenePix Pro is used to control the GenePix scanner, you can use the 

software purely as an analysis platform.  To do this, you need to be able to import 

array images in 16-bit TIFF format. 

Spots, Features, Blocks and Arrays 
Before we can discuss image analysis in GenePix Pro, we need to become familiar 

with some basic terminology.  This information is discussed fully in Chapter 4, so 

only the key concepts are highlighted here.   

Within GenePix Pro each individual spot on the array is called a feature, and is 

assigned a circular feature-indicator.  Feature-indicators are the primary unit of 
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analysis in GenePix Pro.  A collection of feature-indicators is called a block.  There 

can be several blocks on a single array, depending upon the type and configuration 

of the arrayer that was used to place the features on the slide (see Figure 2 in 

Chapter 4). 

Array Lists and the GenePix Pro Array List Generator 

To employ the full power of automated array analysis possible in GenePix Pro 6.0, 

you can use the Array List Generator to construct a GenePix Array List (GAL) file.  

GenePix Pro uses GAL files to construct an array of blocks to match the size and 

positioning of printed features, and to apply substance names to the features.  It is 

critical that the identity of the substance in each spot is maintained throughout the 

analysis, so use a GAL file when you have files containing substance IDs and 

names for each spot on the array.  Substance IDs must be unique identifiers, such as 

Swiss-Prot and FlyBase identifiers, or GI (GenInfo Identifier) numbers.  For more 

information on the format and content of GAL files, see our webpage:  

http://www.axon.com/GN_GenePix_File_Formats.html 

The Array List Generator is designed to work with arrayers and arrays that have the 

following characteristics: 

!# The slides and source plate(s) are perpendicular to one another. 

!# The robotic motions follow a raster pattern (left to right, then down, left to 

right again), both in loading samples from the source plate, and when 

depositing subsequent spots onto slides (movement between slides does not 

have to follow a raster pattern). 

!# There are no replicate spots (although there can be replicate samples in the 

microplate wells). 

!# There is one block of spots per pin being used (e.g., 4 pins = 4 blocks of  

m rows and n columns). 
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Therefore, you cannot use the Array List Generator to automatically create a GAL 

file in the following cases (although you may always create one manually):  

!# Arrays where the printhead is in the opposite orientation to the slide  

(e.g., pin 1,1 dips into well A,12). 

!# Replicate spots of any nature (either in adjacent spots, or in separate blocks). 

However, the user can manually edit the GAL file to insert replicates. 

!# Non-standard robotic movements, such as printing out of sequence  

(e.g., returning to previously used wells in the source plate). 

!# Robotics movements that are non-raster (such as top to bottom, then over), 

either in loading sample from the source plate, or in the slide spotting pattern. 

!# More than one block per pin. 

!# Slides printed on arrayers from Affymetrix/GMS, Amersham Pharmacia 

Biotech/Molecular Dynamics, or Intelligent Automation Systems (IAS). 

!# Slides printed on other commercial arrayers that do not conform to the 

aforementioned specification. 

Many commercial arrayers automatically generate GAL files.  If your arrayer does 

not have GAL output functionality, please contact your arrayer manufacturer 

directly and request GAL file support. 

A standard GAL file contains at least four, and at most five, data columns 

containing position and identity information for each feature:  ‘Block’, ‘Column’, 

‘Row’, ‘ID’ and optionally, ‘Name’.  A new feature in GenePix Pro 6.0 is the 

ability to read GAL files containing user-defined columns beyond these five, should 

you wish to include extra annotation information about your features—for example, 

their status as normalization spots.  Of course GenePix Pro 6.0 will still read 

standard GAL files, and any extra columns in a new-format GAL file are simply 

ignored by previous versions of GenePix Pro. 

To load a GAL file into GenePix Pro, use the Load Array List command (available 

under the File... button on the right-hand side of the GenePix Pro window). 
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Barcode Reading 
If a slide has a barcode on it, GenePix Pro automatically reads the barcode symbols 

from Preview Scans, Data Scans and saved images.  The extracted barcode symbols 

are reported in the “B:” field in the Status Bar at the bottom of the GenePix Pro 

window, and are exported in the header of the Results file.  In addition, you can use 

the barcode symbols as the file name of the image.  To do this, check the Barcode 

option in the Save Images dialog box.   

GenePix Pro reads four of the most common barcode formats—code 39, code 128, 

code I2of5 and codabar—which have the following properties: 

 

Barcode 
Type 

Numerical 
Characters 

Alpha 
Characters 

Special 
Characters 

String Length 

Code 39 0–9 A–Z, space –  $  %  +  / no limit 

Code 128 All ASCI characters no limit 

Code I2of5 0–9 N/A N/A no limit (even) 

Codabar 0–9 N/A - : . $ / + no limit 

 

If you know the type of barcode that your slides use, you can set the barcode 

detection so that it searches only for that type.  This speeds up the detection 

process.  Open Options / Workflow and click the Barcode Types button. 

Image Display 
The GenePix 4100 and 4200 scanners operate using sequential scanning:  that is, 

the slide is scanned twice, first using one color laser, and then the second.  The 

images at the two wavelengths are displayed as they are acquired in real time; a 

ratio image appears as the second wavelength image is superposed on the first.  The 

GenePix 4000 scanner uses a simultaneous dual-laser scanning system to acquire 

and display both wavelength channels as a ratio image in real time.   
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How a Ratio Image is created 

In GenePix Pro, each raw wavelength image, such as the green 532 nm image or the 

red 635 nm image, is collected at 16-bit resolution.  GenePix Pro ratio images are 

standard 24-bit composite RGB (Red-Green-Blue) images.  When GenePix Pro is set 

to the default red–green display scheme in two-color mode, with the default ratio 

formulation, the image from the 532 nm laser is placed in the green channel, and the 

image from the 635 nm laser is placed in the red channel.  The blue channel is set to 0.  

So each color channel of the RGB images is composed only of an 8-bit image.  

This means that the ratio image is not, strictly, an image of the ratio data.   

For display purposes only, each of the individual wavelength images must be 

reduced to 8 bits in order to be displayed as a 24-bit composite RGB overlay image.  

There are two options to reduce each raw wavelength image to 8 bits:  

!# compress 16 bits into 8 bits, or  

!# selectively use only 8 of the 16 bits.   

GenePix Pro provides the ability to do either using commands in the Color menu.   

To compress the 16 bits into 8 bits, the software uses a square root transform, 

whereby the square root of the image intensity is computed and displayed, which 

effectively reduces 16 bits to 8 bits (${216} = 28).   

Alternatively, to strip out 8 of the 16 bits, GenePix Pro can be configured to keep 

only the bottom, middle or top 8 bits.  The effect of each of these options on the 

range of the intensities that is used to display the ratio image is summarized in the 

table below: 

Method of Ratio Processing Range of image intensity that is used 

Square Root Transform 0–65535 

Preserve High Intensities 256–65535 

Preserve Middle Intensities 16–4095 

Preserve Low Intensities 0–255 
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What happens if you have selected a ratio processing method and you have pixels 

that are outside the range of acceptable intensities?  

First, it is important to remember that the ratio processing method affects only the 

display of the ratio; it does not have any effect on the display of the raw wavelength 

images, nor does it affect the computation of the ratio data displayed in the Results tab.   

Ratio processing is best illustrated with an example.  Suppose you have a pixel that has 

a green value of 15000 and a red value of 30000.  If the ratio that you are computing is 

based on red divided by green, the ratio value would be 2 (30000 / 15000).  If you are 

using the “Square Root Transform” method, you can display all pixels from 0 to 65535.  

In this scenario, the pixel in question is red, as the red channel is contributing twice the 

intensity to the RGB image as the green channel.   

However, when you select “Preserve Low Intensities” the maximum pixel value is now 

255.  In this case, both the green and red pixels are contributing the same intensity to 

the RGB image since each image is effectively treated as 255.  This is because both 

images exceed an intensity of 255, and are thus clipped at a value of 255.  The result is 

a ratio displayed that is yellow, corresponding to a ratio of 1 (255 / 255). 

Although GenePix Pro can analyze four individual wavelength channels, a ratio 

image can only be created from two at a time.  The user can specify up to three 

independent pairs of channels to display as ratio images. 

Biology of a Ratio Image 

The ratio image typically represents the comparison of test to reference substance 

that is bound to the spotted (or arrayed) substance.   

Suppose the reference substance is labeled with Cy3 (which is excited by green 

laser light such as 532 nm), and suppose the test substance  is prepared in the 

presence of Cy5 (which is excited by red laser light such as 635 nm).  Both of these 

substances are mixed with and bind to the spotted substance on a slide.  In the 

derived ratio image, a red spot indicates that the test substance for this feature is 

more abundant than the reference substance, which means that it has a higher 
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activity than the reference; a green spot indicates that the test substance has a lower 

activity than the reference substance; a yellow spot means that there is no change in 

the activity level between the two populations of test and reference substance. 

Analysis Algorithms 
To quantify changes in activity accurately, you must extract the intensity of a given 

feature from an image, and refine this data before a final ratio value is computed.  

In addition, several other parameters are measured to evaluate the quality of the 

data for a given feature.  The following section describes how each computation in 

GenePix Pro is performed. 

Computing Feature Intensities 

For each raw image, the mean, median, and standard deviation of the pixel 

intensities in each feature-indicator is computed.  The pixels that are used to 

compute the standard deviation include all of the pixels that are completely inside 

the feature-indicator.  Any pixel that contacts the boundary that defines the feature-

indicator is excluded. 

Computing Background Intensities 

The fluorescent intensity that is measured inside a feature usually includes a certain 

amount of stray fluorescence from various sources: 

!# auto-fluorescence of the slide 

!# non-specific binding of test and reference substance. 

This stray fluorescence, known as background, needs to be subtracted from the 

measured feature intensity in order to come to a true measure of the fluorescence of 

a feature. To this end, GenePix Pro 6.0 offers four different classes of background 

subtraction methods: 

!# local methods 
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!# global methods 

!# negative controls 

!# morphological methods. 

Each background subtraction method has advantaged and disadvantages. 

The local median intensity is the default GenePix Pro background subtraction 

method. Local methods, where the background value for a feature is calculated 

from a region near the feature, have the advantage that they track background 

variation across a slide. However, they can be unrealistically high or low if there 

are local defects near a feature, and thus they may not be representative of the 

background contribution inside a feature.  

In particular, if background fluorescence is due to non-specific binding, and if non-

specific binding is more likely to occur on features than between features, then 

background estimated from regions between features may underestimate the 

background fluorescence within features. 

Global background methods, where a single background value is calculated for 

each wavelength, have the advantage of providing a uniform background estimation 

for a whole slide, particularly when features are so close together that local methods 

cannot be applied. However, where the background varies significantly across a 

slide, one single estimate may not accurately represent the background contribution 

to all features. 

Negative control methods, where the background for a feature is estimated from 

the intensity of a nearby feature, have a number of advantages over local and global 

methods.  

Negative controls are features that are known not to be reactive, so that they can 

relied upon always to give the same intensity values independent of the experiment. 

First, if background is due to non-specific binding, then it is plausible that non-

specific binding is higher where features have been printed on a slide, compared to 

the space between features.  Thus is makes sense to estimate non-specific 
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fluorescent background from negative control features, rather than from local 

regions between features. 

Second, if implemented correctly, background intensities can be calculated from 

negative controls close to a feature, and thus will vary as the background varies 

across a slide. Thus negative control methods have the advantages of local methods, 

with none of the disadvantages. 

However, unlike all the other background subtraction methods, which are purely 

computational and can be applied to any slide, negative controls must be part of 

microarray slide design from the beginning. 

Morphological methods address a problem that all of the other three methods can 

exhibit, namely that the background estimated for a feature can be higher than the 

feature’s intensity. This situation is rather catastrophic, as a negative background-

subtracted intensity leads to a negative ratio, and hence an undefined log ratio, 

meaning that the feature is lost from all further data analysis. 

In morphological methods, a copy of each single-wavelength image is created, and 

then each image is filtered to construct a background image for each wavelength. 

GenePix Pro employs two different morphological background methods: 

!# Closing followed by opening. Small dark regions are filled in on the 

background image, then a local minimum filter is applied to the whole 

image. 

!# Opening. A local minimum filter is applied to the whole image. 

The Opening method produces a significantly lower estimate of background than 

any other background subtraction method. It guarantees that the background 

estimate is always lower than the feature intensity. However, it may underestimate 

the true background level. 

Compared to the default local background subtraction method, Closing followed by 

Opening produces background estimates that are slightly lower for regions of low 

background, but significantly lower for regions where there are bright patches in the 
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background. However, background-subtracted intensities can still be negative using 

this method. 

Regardless of the method chosen, the calculated background intensity is subtracted 

from the feature intensity before any ratios are calculated.   

Local Methods 

In local background subtraction methods, a different background is computed 

for each individual feature-indicator, and the mean, median and standard 

deviation of the background pixel intensities are reported.  For all ratio 

calculations that require background subtraction, the median background value 

is used.   

The background is calculated using a circular region that is centered on the 

feature-indicator.  This region has a diameter that is three times the diameter of 

the corresponding feature-indicator.  All of the pixels within this area are used 

to compute the background unless one of the following is true:  

!# the pixel resides in a 

neighboring feature-indicator; 

2-pixel exclusion region

background pixels

feature pixels

!# the pixel is not wholly outside 

a two pixel wide region around 

a feature-indicator; 

!# the pixel is within the feature-

indicator of interest.  

In Figure 1, the black region represents 

the pixels used for computing the 

background, the dark gray region 

represents the pixels used for the 

feature intensities, and the light gray 

region represents excluded pixels.  

Figure 1.  Defining background pixels. 
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The diameter of the background region and the width of the exclusion region 

around a feature are user-configurable. Typically, you would make the 

exclusion region smaller and the diameter of the region larger as the density of 

features on your arrays increases. 

To change these settings: 

!# Click the Options button on the right-hand side of the GenePix Pro 

main window. 

!# Switch to the Analysis tab. 

!# Under Background Subtraction, edit the values for the exclusion region 

and the background region. 

In addition to computing the local background, GenePix Pro reports the 

percentage of pixels that exceed several local background-related thresholds: 

the percentage of pixels that are greater than the background+1 standard 

deviation, and background+2 standard deviations.  These threshold-related 

values are often useful in evaluating the quality of the data. 

Global Methods 

GenePix Pro 6.0 offers several global background subtraction methods.  In a 

global method, a single value for the background is used for a whole array at 

each wavelength.   

The global background values are either calculated from a mean or median of 

all local values, or specified by the user as individual values for each channel.  

Negative Controls 

To use negative control background subtraction, you must identify features as 

negative controls by giving them a characteristic substring in their ID. By 

default, GenePix Pro looks for the substring "_NCTRL".  For each feature, the 

Name of the nearest negative control in the same block appears in the Negative 

Control column in the Results tab. 
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The identifying substring is not case-sensitive, so you can use "_nctrl" or 

"_Nctrl", for example. 

Morphological Methods 

Morphological background subtraction starts with a copy of the image and 

filters it to construct a background image. The background value for a feature is 

then the intensity at the feature’s center on the background image. 

Closing removes small dark regions from the image. Any dark region that fits 

into a square with sides given by the closing value is removed from the image. 

Closing prevents the measured background from being too low. 

Opening removes bright regions. It is the inverse operation of closing. Any 

bright region that fits into a square with sides given by the opening value is 

removed. Opening prevents the measured background from being too high.  

If the opening value is too small then features may not be removed from the 

background image. This typically happens on high-density arrays where the 

features are very close together. 

Block Alignment and Background Thresholds 

To align a feature-indicator with a feature, the GenePix Pro’s proprietary spot-

finding algorithm makes several assumptions about feature intensity relative to the 

intensity of the background, feature size, and feature position.   

A feature is marked ‘Not Found’ if: 

!# the feature has fewer than 6 pixels; or 

!# the feature diameter found is greater than the lesser of:  (a) three nominal 

diameters (as set in Block Properties) or, (b) the diameter that would cause 

it to overlap an adjacent feature of nominal diameter; or 

!# the feature diameter goes outside the bounds set in Options / Alignment; or 
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!# the feature has been found in a position that would overlap an adjacent 

feature. 

If the spot-finding results in feature indicators that are larger than your features, it 

can be due to extreme background variation:  bright background pixels may be 

included as feature pixels.  To avoid this, try increasing the Composite Pixel 

Intensity threshold value in the Alignment tab of the Options dialog box to a value 

slightly higher than the brightest background pixel near your features. 

Computing Ratios 

GenePix Pro 6.0 computes a large number of different ratio quantities, each of 

which provides a different insight into the raw data.  The main ratio quantities are 

described on the following pages and their significance is briefly discussed.  They 

are divided into three different subgroups:  those that are ratios of quantities derived 

from whole features (such as median and mean pixel intensities), those that are 

derived from pixel-by-pixel ratios of intensities, and quality factors. 

All ratios and derived quantities are corrected for background effects.  Pixel 

intensities at a wavelength have the median intensity of background pixels at that 

wavelength subtracted from them to produce a corrected intensity. 

To get a better understanding of ratio computations it is useful to examine the Pixel 

Plot (press %P& when the cursor is over a selected feature-indicator).  This plot 

shows you the pixel values for a selected feature, so you can see the contribution of 

each pixel to a ratio value. 

Note:  The form of all ratio calculations in GenePix Pro 6.0 is user-selectable from 

the Options / Analysis / Ratio Formulation dialog box.  In this Guide, we assume that 

wavelength 2 is always in the numerator and wavelength 1 is in the denominator.  

Ratios of Overall Derived Feature Properties 

In ratiometric fluorescence studies we are typically most interested in the 

difference in activity levels between the test and the reference substance.  This 

eventually translates to differences in intensity on the two images analyzed by 
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GenePix Pro, which can be quantified by taking a ratio of image intensities for 

each feature.  Because each feature on the image is made up of many pixels, we 

need a method of finding a representative intensity for each feature.   

Ratio of Med ans i

Median intensities are often preferred to arithmetic mean intensities 

because they are not as seriously affected by extreme values at either end of 

a distribution.  The ratio of medians is the ratio of the background 

subtracted median pixel intensity at the second wavelength, to the 

background subtracted median pixel intensity at the first wavelength. 

Ratio of Means 

Mean intensities are familiar quantities, but they can be significantly 

skewed by extreme values at either end of a distribution.  However, 

calculating the mean allows you to evaluate the variability of the data.  This 

variability is reported as the standard deviation.  The ratio of means is the 

ratio of the arithmetic mean of the background-subtracted raw pixel 

intensities at the second wavelength, to the arithmetic mean of the 

background subtracted raw pixel intensities at the first wavelength. 

On grounds of consistency you might expect to use the mean background 

instead of the median background when using the mean intensity.  

However, it is more important to use the most reliable value for the 

background than to be consistent simply for the sake of it.  The fact that 

means can be skewed by extremely low and high values suggests that you 

should use the median background. 

Quantities Derived from Pixel-by-Pixel Ratios 

An alternative to computing the ratio from calculated means and medians of 

each whole feature is to compute the ratio on a pixel-by-pixel basis, and then to 

calculate the arithmetic mean and median of these many ratio values.  An 

advantage of this approach is that non-specific signal, which appears in both 
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wavelength images, has less of an effect than when the feature is treated as a 

whole. 

Median of Ratios 

As is the case with the overall derived feature properties, median intensities 

are often preferred to mean intensities because they are not as seriously 

affected by extreme values at either end of a distribution as compared to the 

arithmetic mean.  The median of ratios is the median of the pixel-by-pixel 

ratios of pixel intensities that have had the median background intensity 

subtracted. 

Mean of Ratios 

The mean of ratios is the geometric mean (i.e., the mean in log space) of 

the pixel-by-pixel ratios of the raw pixel intensities. 

Regression Ratio 

The regression ratio is a method of computing the ratio that does not 

require rigidly defining background and foreground pixels, so it is the most 

objective of the three methods.  Every pixel within a circle of twice the 

diameter of the feature of interest is used.  The relationship between 

wavelength 1 and wavelength 2 is determined by computing a linear 

regression between these two populations of pixels.  The slope of the line 

of best fit (least-squares method) is the regression ratio.  The coefficient of 

determination provides a measure of the level of accuracy of the fit. 

Because the regression ratio does not make any assumptions about which 

pixels are feature pixels, and which pixels are background pixels, saturating 

pixels can distort the regression ratio as they heavily weight the slope of the 

best-fit line.  On a good array, all of the ratio values tend to converge.  If 

the regression ratio is significantly different from the other ratio quantities 

for some of your features, look at each of these features in more detail to 

determine what is causing the deviation.  The Pixel Plot (Hot Key %P& with 

the mouse cursor over a feature-indicator) is a useful tool for this. 
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Quality Factors 

Sum of Medians and Sum of Means 

The sum of medians and the sum of means are useful measures to interrogate 

the quality of an individual feature.  If either sum is unreasonably low, this 

indicates that there is very little signal in both channels, suggesting that any 

ratio derived from this feature should be interpreted with caution. 

The sum of medians is the sum of the median of the pixel intensities at each 

wavelength, with the median background pixel intensity at each wavelength 

subtracted.  

The sum of means is the sum of the arithmetic mean of the pixel intensities at 

each wavelength, with the median background pixel intensity at each 

wavelength subtracted. 

As of GenePix Pro 6.0, these quantities are calculated on a per ratio channel 

basis; that is, for each pair of wavelengths in a ratio, a separate sum of medians 

and sum of means column is calculated. 

Log Ratio 

The log ratio is a base two logarithm of the ratio of medians.  This type of log 

transformation is often used in ratiometric studies as it helps to compare levels 

of over-activity and under-activity.  For example, if you have a four-fold 

increase in activity (i.e., a ratio value of 4), the log base 2 ratio is +2; if you 

have a four-fold decrease in the ratio (i.e., a ratio value of 0.25), the value is –2.  

The log base two transform is simply a quicker way of observing the similarity 

of these two conditions. 

Signal to Noise Ratio 

Signal-to-noise is important for determining the confidence with which one can 

quantify a signal peak of a given value, especially a signal near background.  

The confidence in quantifying the peak increases as the variation in 
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background signal (the ‘noise’) decreases, regardless of the absolute value of 

the average background. 

One can easily compute the signal-to-noise ratio (SNR) by measuring the mean  

signal intensity for a feature, subtracting the mean background signal, and 

dividing by the variation in the background, so the signal-to-noise ratio is defined 

as: 

(F635Mean – B635Mean) / B635SD 

where F635Mean is the mean of all the feature pixel intensities at 635nm, 

B635Mean is the mean of all the background pixel intensities at 635nm, and 

B635SD is the standard deviation of the background pixel intensities at 635nm. 

Because medians are more robust to outliers than means, we typically 

recommend the median instead of the mean as a measure of feature or 

background intensity. However, because the signal-to-noise ratio is well 

understood theoretically when calculated using means, and a threshold of 3 is 

well established as a measure of detectability, we calculate the signal-to-noise 

ratio using the mean intensity and mean background. 

Flags 

GenePix Pro 6.0 provides the ability to flag individual features manually with 

quality flags, such as ‘Good’, ‘Bad’, ‘Absent’ or ‘Not Found’ Flags are also 

used to indicate which features to use in the normalization of the image.   

The ‘Bad’ flag is useful when doing a cursory analysis of your images.  If you 

observe a region where the features are sub-standard, you can flag them ‘Bad’ 

and a flag value of –100 is noted in the analysis results.   

Alternatively if you see a feature that shows some especially promising 

properties, you may want to flag it ‘Good’.  If so, a flag value of +100 is noted 

in the Results.  Select flagging commands from the right mouse menu in the 

Image tab, the Results tab or the Scatter Plot tab, or from the Feature menu on 

the right-hand side of the GenePix Pro main window. 
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‘Absent’ (numerical value –75) is applied to a feature when a GAL file is 

missing an entry for a feature, or when the ID is ‘Empty’. 

A feature is flagged ‘Not Found’ (numerical value –50) when Align Blocks fails 

to align a feature-indicator.  See above Section “Block Alignment and 

Background Thresholds”, for conditions under which alignment can fail. 

In GenePix Pro 6.0, the Good and Bad flag values are different when they are 

applied from the Flag Features dialog, so that you can separate manual from 

automatic flagging procedures in your downstream analyses. A Good flag 

applied from Flag Features is given the value 99, while a Bad flag is given the 

value –99. 

A second type of flag is the Normalize flag.  It has its own column in the Results 

tab, and is used to mark features for use in Normalization.  For each feature you 

can choose to Include in Normalization or Remove from Normalization.  When 

exported, these flags have the values 1 and 0 respectively. 

Features can be flagged according to general Boolean conditions using the Flag 

Features dialog box.  In this dialog box you can construct queries by selecting 

commands with buttons, or you can type in any arbitrary expression in VBScript.  

The expression is evaluated for each row in the Results tab, and features are 

flagged according to whether or not the expression is true or false for them.  See 

“Defining Your Own Flagging Criteria”. 

Data Normalization 

Origins of Variability 

Comparing the data from different array experiments is a non-trivial task.  Small 

variations in the many steps that produce an array image can make comparisons 

across arrays problematic.  Variations can be due to differences in labeling 

efficiencies (dye and batch variations), chemical properties of different dyes, pin 

tips, slide batches, and scanner settings (e.g., red/green channel settings, multiple 
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scanners).  Any of these variations can be corrected by normalization.  No one 

normalization method will correct all types of variation.  Choose a normalization 

method based on the known or expected sources of error, and the characteristics of 

the experiment.  Validate the method empirically, for example by reversing the dye 

labeling to test a normalization method for channel balancing.   

In the acquisition step of an experiment, one of the main contributors to variability 

between arrays is setting PMT values incorrectly, so that the total signal acquired in 

one channel is significantly different to the total signal acquired in the other.   

(We are assuming that when scanning a particular sample, the total signal in each 

channel is in fact the same.)  In such a case ratio values may be biased towards one 

channel.  To minimize this form of variability, you should perform preliminary 

scans to adjust the PMTs so that they are producing roughly the same response in 

both channels.  See “Optimizing Hardware Settings” in Chapter 4. 

Normalization Methods 

In the analysis step, you can improve comparisons across many arrays by 

normalizing the data from each array.  One method of normalization is based on the 

premise that most genes on the array will not be differentially expressed, and 

therefore the arithmetic mean of the ratios from every feature on a given array should 

be equal to 1.  If the mean is not 1, a value is computed which represents the amount 

by which the ratio data should be scaled such that the mean value returns to 1.  This 

value is the normalization factor. 

Another method is to choose a subset of the features on an image as control 

features.  All substances change expression levels under different conditions.  

Normalization control features should be selected based on their consistent 

behavior in all experimental conditions used on your arrays, not on their historical 

use as “housekeeping genes” in other molecular biology techniques.  For example, 

the control spots might be such that each is expected to have a ratio of 1.  Hence the 

mean of the control features should be 1.  Assuming that variations are uniform 

across the array, a single normalization factor can be calculated from these features 

and then applied to the whole array. 
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Normalizing 

Having chosen a normalization method, it must be implemented in software. 

GenePix Pro employs a global normalization method, in which images and Results 

are normalized together.  If the current Results are not derived from the current 

images (i.e., if they are not linked), then Results data are normalized alone; see 

Chapter 4, “Linkage”.  You can always remove normalization to return to your 

original images.  

Because ratios are not normally distributed, GenePix Pro first takes the log of each 

ratio value when normalizing.  The mean x  of a set of n ratios {x} is therefore:  
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Ratio values less than 0.1 or greater than 10 are excluded from the calculation, as 

are features flagged Bad, Absent or Not Found. 

Four-color normalization is done on a ratio-by-ratio basis.  For example, if you 

choose to normalize so that the mean of the Ratio of Medians is set to 1.0, each 

Ratio of Medians data type that you have defined in the Options / Analysis / Ratio 

Formulation dialog box is normalized independently.   

To calculate the wavelength-specific normalization factors that are reported in the 

Results Header, the change to the ratio is distributed equally between the 

wavelengths, so one wavelength scales up by the square root of the ratio scale 

factor and the other scales down. 

For example, suppose the mean of Ratio of Medians of 635/532 is 1.21.  The square 

root of 1.21 is 1.1, so we set the scale factor for the 532 wavelength to 1.1, and the 

scale factor for the 635 wavelength to 1/1.1 = 0.91.  After applying these scale 

factors, the new mean of the Ratio of Medians is 1.21 * 0.91 / 1.1 = 1.0. 

Because normalization can scale up the data, it is possible for normalization to 

produce pixels with intensities greater than the hardware limit of 65535.   
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GenePix Pro File Formats 
GenePix Pro 6.0 recognizes and uses several different file types.  Detailed 

descriptions of the file formats used by GenePix Pro can be found on our website at: 

http://www.axon.com/GN_GenePix_File_Formats.html 

ATF—Axon Text File Format (*.atf)  

This is a tab-delimited text file format that can be read by typical spreadsheet 

programs such as Microsoft Excel.  It is used for GenePix Array List (GAL) files, 

and GenePix Results (GPR) files (see following page). 

An ATF text file consists of records.  The group of records at the beginning of the 

file is called the file header.  The file header describes the file structure and includes 

column titles, units, and comments.  Each line in the text file is a record.  Each 

record may consist of several fields, separated by a field separator or column 

delimiter.  The tab and comma characters are field separators.  Space characters 

around a tab or comma are ignored and considered part of the field separator.  Text 

strings are enclosed in quotation marks to ensure that any embedded spaces, 

commas and tabs are not mistaken for field separators. 

GAL—GenePix Array List File (*.gal) 

The GenePix array list file conforms to the Axon Text File (ATF) format.  The 

GenePix array list file contains entries to describe the layout of each block, and to 

assign names and identifiers (IDs) to each feature on an array.  New to GenePix Pro 

6.0 is the ability to read GAL files with user-defined data columns beyond the usual 

five; information in user-defined columns is preserved and written to the GPR file 

when Results are saved.  See the on-line Help for more details. 

GPA—GenePix Settings File Settings (*.gpa) 

Settings for batch scanning (which GPS or GAL file to use, Auto PMT setting, etc, 

for each slide) are saved as a binary file. 
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GPR—GenePix Results File (*.gpr) 

Results data are saved as GPR files, which are in Axon Text File (ATF) format  

(see previous page).  The results file contains general information about image 

acquisition and analysis, as well as the data extracted from each individual feature.  

Results can be saved with the entire table in a single GPR file, or with each block in a 

separate GPR file. 

GPL—GenePix Lab Book File (*.gpl) 

The GenePix Lab Book is a binary file, so the user cannot edit it.  See Chapter 4, 

Section 3, Special Functions, for information on using the Lab Book. 

GPS—GenePix Settings File (*.gps) 

GenePix Pro acquisition, analysis and display settings are saved as binary GenePix 

Settings Files.  Settings are organized into several different categories (acquisition, 

analysis and display) all of which are saved together in the GPS file.  However, when 

opening a settings file you can choose which subset of the settings you want to open. 

Acquisition settings include which laser was enabled during the acquisition, the PMT Gain 

settings, the lines averaged, and the scan area.  Analysis settings include the location and 

identification of blocks and feature-indicators that were defined on the image.  Display 

settings include brightness and contrast settings, and the ratio color mapping. 

GPS files and GAL files both contain block and feature geometry, and both can be 

used to apply a grid template to an image.  However, a GAL file does not contain 

the acquisition and display settings that are saved in a GPS file. 

JPEG—Joint Photographic Experts Group (*.jpg) 

Images can be saved in the JPEG format, which is a lossy, compressed image file 

format.  That is, it removes some information from the image as it makes the image 

much smaller than an image saved in a non-lossy format such as TIFF.   
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GenePix Pro implements minimal JPEG compression, which is enough to reduce 

image file size significantly, but which removes only a small amount of data from 

the image.  However, we recommend that you do not use the JPEG format to 

archive images that are to be analyzed later.  Rather, use the JPEG format to store 

images that are to be used in presentations. 

TIFF—Tagged Image File Format (*.tif) 

Images acquired in GenePix Pro are by default saved in the TIFF format.  This is a 

standard, uncompressed graphic file format that can be read by many graphics and 

imaging programs.  The primary data acquired by GenePix Pro are the single-

wavelength images, and by default these are saved as 16-bit grayscale TIFFs in a 

single multi-image TIFF file.  Not all graphics applications can read multi-image 

TIFF files.  You may want to try opening a multi-image file with your preferred 

graphics application to see if they are supported.  If not, save the single-wavelength 

images as separate single-image files.   

GenePix Pro exports its preview and pseudocolor ratio images as 24-bit color 

TIFFs, but it does not read them, as data are not extracted from them. 
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Chapter 4 
 

 Tutorial 

This tutorial guides you through loading your first array and scanning your first 

array image.  It also leads you through a basic array analysis, and describes more 

advanced GenePix Pro functionality. 

The tutorial is organized into three main sections. 

Image Acquisition 

Image Acquisition begins with starting the GenePix scanner and takes you through 

to scanning an array and saving your images.  If you are using GenePix Pro as a 

standalone application, you may want to skip this section.   

Image Analysis 

Image Analysis begins with loading an image into GenePix Pro, and takes you 

through all the analysis steps required to extract data from the image.  

Special Functions 

Special Functions describes all the special features in GenePix Pro that you may use 

regularly. 
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Using the On-line Help 
If you require more information about details of the GenePix Pro software 

interface, consult the on-line Help, which you can do at any time from 

within GenePix Pro by pressing %F1&.  

If you would like more information about the technical details behind the GenePix 

array scanning system, consult Chapter 3 above, or Chapter 4 in the User’s Guide 

for your GenePix scanner.  

Image Acquisition 

Starting GenePix Pro 

If you have not yet performed the GenePix scanner installation, refer to the User’s 

Guide for your scanner. 

The GenePix scanner must be running before your computer is powered up so that 

the computer can identify that the scanner is connected and operational.   

IMPORTANT:  After power-on, give the scanner 15 minutes to warm up before 

acquiring any images with it.  This allows time for the lasers’ output to stabilize.   

GenePix Pro Analysis Only Mode 

During the installation of GenePix Pro, one of the icons created in the Start menu 

group is labeled “GenePix Pro 6.0 (Analysis Only)”.  Both versions provide exactly 

the same functionality, except that the Analysis Only version does not interact with 

the GenePix scanner.   

Note:  In previous versions of GenePix Pro, ‘Analysis Only’ mode was referred to 

as ‘Demo mode’. 
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You may want to use the Analysis Only version in several circumstances: 

!# You can use the Analysis Only version to mimic the scanning process if 

you do not have a scanner available as you go through this Tutorial.  

Pressing a scan button in the Analysis Only version displays a demo image 

that can be used for this Tutorial.  The GenePix Pro installation includes all 

the necessary settings and analysis files to accompany the demo image. 

!# If you are acquiring image data with one computer and then performing 

analyses on another, running the hardware-interactive version on the 

computer without the scanner results in prompts about the scanner not 

being attached.  When running the Analysis Only version you have full 

analysis functionality without having to worry about scanner connections.   

!# If you are acquiring and analyzing on the same computer, there is an 

advantage in using the Analysis Only version only for analyses, particularly 

if they are lengthy.  While the hardware-interactive version of GenePix Pro 

is running, the scanner’s lasers are fully powered (although the lasers power 

down if the scanner is left idle for two hours).  Exiting from the hardware-

interactive GenePix Pro software powers down the lasers on the scanner 

immediately.  In the long term, switching to the Analysis Only version for 

analyses may extend the lasers’ operating lifetime. 

Performing a Preview Scan 

For information on inserting and removing arrays, please refer to the User’s Guide 

for your scanner. 

Use a 40 µm Preview Scan to find the area on the array that you want to scan at 

high resolution.  After completing a Preview Scan, you typically set a Scan Area 

and then do a high resolution Data Scan. 
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To perform a Preview Scan: 

!# Launch the GenePix Pro software. 

!# Insert a slide with the arrayed features facing down. 

!# Press the Preview Scan button on the right-hand side of the 

GenePix Pro main window. 

GenePix Pro can be configured so that after a Preview Scan, it reads the barcode 

from the slide automatically: 

!# Click the Options button on the right-hand side of the GenePix 

Pro main window. 

!# Click the Workflow tab. 

!# Check for Search for a barcode after each data scan or image load check box. 

The barcode is reported in the “B:” field in the Status Bar at the bottom of the 

GenePix Pro main window. 

Drawing a Scan Area 

Once you have a Preview Scan, you can draw a Scan Area around the features on 

your array.  This area only is scanned during a Data Scan (see below).  If you do 

not draw a Scan Area, the whole slide is scanned during the Data Scan. 

To draw a Scan Area: 

!# Select the Scan Area tool from the Tools group on the 

left-hand side of the Image tab. 

!# Move the mouse cursor to the top left of the features on the image. 

!# Hold down the mouse cursor and drag a rectangle around the region 

containing the features. 

!# Press %5& if you want to zoom in to the Scan Area. 

GenePix Pro 6.0 User’s Guide,  Copyright 2005  Axon Instruments / Molecular Devices Corp. 



Tutorial  !  39 

Performing a Data Scan 

A Data Scan is a high-resolution scan that is used for data analysis.  Data Scans can 

be done at several different pixel sizes (resolutions) from 5 µm to 100 µm.  

Scanning at 5 µm is useful primarily for analysis of features smaller than about  

100 µm in diameter.  A 100 µm feature scanned with 10 µm pixels contains about 

78 pixels, which is sufficient for an accurate intensity measurement.  For features 

larger than 100 µm, the negligible difference in accuracy is unlikely to justify the 

four-fold increase in file size and the two-fold increase in scan time required by a 5 

µm scan. 

To change the resolution for a Data Scan: 

!# Press the Hardware Settings button on the right-hand side of the GenePix 

Pro main window. 

!# Use the spinner buttons to change the value in the Pixel Size field. 

To perform a Data Scan: 

!# Press the Data Scan button on the right-hand side of the GenePix Pro 

main window. 

During scanning, all of the image display controls and zooming functions are fully 

operational.  See “Image Analysis” section.   

Performing a Single Wavelength Scan 

If you have scanned two, three of four wavelengths (depending on your model 

scanner), and one of the wavelengths scans was done at an incorrect PMT setting, 

for example, you can use a Single Wavelength Scan to scan just that wavelength 

again, while retaining all the other wavelengths. 

To use Single Wavelength Scan: 

!# Specify the wavelength to scan by selecting it in the Image 

group at the top left of the Image tab. 

!# Click the Single Wavelength Scan button.      
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Note:  When you perform a single wavelength, scan the original image for that 

wavelength is overwritten. 

Optimizing Scanner Settings 

The Hardware Settings dialog box controls many different scanner settings, such as 

PMT gain, laser power (GenePix 4000 scanners), filter selection (GenePix 4100 

scanners), pixel size (resolution), lines to average and focus position. 

Maximizing the Dynamic Range of a Scan 

The complete dynamic range of the scanner is being used when you see a range 

of intensities on the image from 1 to 65535.  A pixel with an intensity of 65535 

is “saturated”.  Saturated pixels represent a condition in which there are more 

photons detected than the PMT can process, or the output of the PMTs exceeds 

the range of the analog-to-digital converters.  A saturated pixel is not an 

accurate measurement of the signal from the pixel, so it is imperative to set the 

PMT Gain to avoid saturation.   

Saturated pixels are drawn as white on the image, and appear on the far right of 

the histogram (on the Histogram tab:  See Section 3, Special Functions). 

To maximize the dynamic range of your scanner for a slide: 

!# Open the Hardware Settings dialog box.  This dialog box can stay open 

while scanning. 

!# Start a Preview Scan by clicking the Preview Scan button. 

!# While scanning, increase the PMT gain for each wavelength with the 

PMT Gain spinner controls until there are no pixels that are saturating 

in each single wavelength image.   

Balancing PMTs 

The ideal scan is one in which the same amount of red and green signal is 

acquired in each channel, resulting in a pixel ratio of approximately 1.0.  Post-

acquisition normalization can correct for variations in relative signal intensities, 
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so scanner settings need only approximate a ratio of 1.0.  Balancing the two 

channels by eye is often sufficient. 

To Balance PMTs: 

!# Open the Hardware Settings dialog box.  This dialog box can stay open 

while scanning. 

!# Start a Preview Scan by clicking the Preview Scan button. 

!# Zoom in to the part of the image that contains the features.  

!# Switch to the Histogram tab.   

!# Set the Min and Max Intensity (Image Balance) fields to 500 and 

65530, respectively. 

!# The Count Ratio field at the bottom left of the Histogram tab reports 

the ratio of counts in each channel.  While scanning, adjust the PMT 

Gain in each channel until this ratio is about 1.0. 

See “Special Functions” below for more details on using the Histogram tab. 

Automatically Balancing PMTs 

Instead of manually adjusting the PMT gain to maximize the dynamic range of 

your and balance the signal from the channels, you can use the automatic PMT 

balancing routine. 

PMT balancing is more effective if your scanner is calibrated (see Calibrate 

System in the “Special Functions” section below). 

To use this routine you need to have a GAL or GPS file for the slide that is 

approximately positioned on blocks of features on the slide.  The GAL file 

should also have accurate default feature diameters.  Any good GAL file will be 

correctly positioned, even before any manual editing or spot finding. 

!# Open the Hardware Settings dialog box.  This dialog box can stay open 

while scanning. 

!# Click the Set PMT Gain button. 
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!# Select the amount of saturation (in terms of the percentage of pixels) 

that is allowed in the scanned image.  We do not recommend setting 

zero saturation, as a bright artifact on the image can cause the rest of 

the image to be scaled so that it is very dim. The default saturation of 

0.005% is recommended for most slides. 

!# There is an option to begin from the current PMT gain.  If this option is 

not checked, then the algorithm begins with a gain of 350.  We 

recommend not beginning from current PMT gain settings, as the 

algorithm is much more effective when starting with low PMT gain 

than with high PMT gain. 

!# Click Start. 

The routine performs a number of Preview Scans at different PMT gain 

settings.  When it is finished, it recommends PMT gain settings to be used for 

your Data Scan: 

!# To accept those gain settings click the Apply button. 

!# To revert to the original gain settings, click Cancel. 

Using Line Averaging 

To maximize the signal-to-noise you may want to average multiple lines.  If 

you set Lines to average to 2, for example, the scanner scans each line twice 

and averages the value.  Keep in mind that as you increase the amount of line 

averaging you correspondingly increase the amount of time needed to complete 

each scan.  For example, averaging two lines doubles the scan time. 

To average more than one line in a Data Scan: 

!# Open the Hardware Settings dialog box.  This dialog box can stay open 

while scanning. 

!# Change the Lines to average field to the number of lines that you want 

to average (e.g., 2). 

!# Start a Data Scan by clicking the Data Scan button on the right-hand 

side of the GenePix Pro main window. 
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Changing Filter Selection 

The Hardware Settings dialog box displays the filter selection field only if your 

GenePix scanner supports the installation of additional custom filters.  Only the 

currently installed filters are displayed. 

The emission filters that come installed as standard in your scanner are 

optimized for use with specific fluorophores—for instance the factory-installed 

filters in the GenePix 4100A scanner are optimized for use with Cy3 (excited 

by 532 nm laser) and Cy5 (excited by 635 nm laser).  You may want to install 

additional filters if you are using dyes with emission characteristics different 

from those for which the standard filters are designed.   

If additional emission filters have been installed on your scanner, you can select 

which filter is used with which wavelength laser scan. 

To change filter selection: 

!# Open the Hardware Settings dialog box.  

!# Change the Filter field for each wavelength to the desired filter. 

Changing Laser Power 

The Hardware Settings dialog box displays laser power adjustment only if your 

GenePix scanner is equipped with this feature. 

You may want to reduce the laser power to avoid photobleaching if you have a 

particularly photosensitive sample, or if you need to scan a slide more than 

once, for example when fine-tuning focal plane adjustments.  (Some dyes, such 

as Cy5, are particularly prone to photobleaching.)  However, reducing laser 

power also reduces signal-to-noise ratio. 

Laser power cannot be adjusted while the scan is in progress. 

To change the laser power: 

!# Open the Hardware Settings dialog box.  

!# Change the Power field for each wavelength to the desired value. 
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Changing Focus Position 

The Hardware Settings dialog box displays focus position adjustment only if 

your GenePix scanner is equipped with this feature. 

You can change the focal point from –50 µm to +200 µm relative to the zero 

position, where a negative value is towards the slide. 

You may choose to focus manually for any sample with appreciable thickness, 

such as one with a cover slip.  The best focus position is that at which the 

intensity is maximized.   

Photobleaching may be a problem if you scan repeatedly to find the right focal 

point.  If you are scanning repeatedly, you may want to reduce laser power. 

The focal plane can be adjusted while the scan is in progress.   

To change the focus position: 

!# Open the Hardware Settings dialog box.  

!# Change the Focus position field to the desired value. 

Saving Hardware Settings 

You can save your acquisition settings, as well as analysis and display 

parameters, in a GenePix Settings (GPS) file.  These settings can be opened 

later for use on other slides. 

To save settings: 

File… 

 

 
!# Click the File… button on the right-hand side of the 

GenePix Pro main window: 

!# Select Save Settings As. 

!# From the Save as type field, select GenePix Settings File (*.gps). 

!# Type in a file name and click Save. 
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Saving Images 

Once your array has been scanned, the next step is to save the images.   

Choosing A File Format 

By default, all images created in GenePix Pro are saved as 16-bit multi-image 

TIFF files.  Each multi-image TIFF file contains the images of the individual 

wavelengths scanned.  The ratio image is not saved because it is recomputed 

when the multi-image TIFF file is opened in GenePix Pro.    

To save images as multi-image TIFFs: 

!# Click the File... button on the right-hand side of the GenePix Pro main 

window. 

!# Select Save Images. 

!# From the Save as type field, select Multi-image TIFF Files. 

!# Click the Save button. 

GenePix Pro also provides the option to save each image component of the 

acquired image as a separate TIFF file.  There are several reasons why you may 

want to do this: 

!# Some graphics applications cannot read multi-image TIFF files; if you 

use one of these, you have to save the images separately if you are 

going to import them into such a program.   

!# You may want to save just the ratio image for presentation purposes.  

You can only save the ratio as a single-image file; it is not saved in the 

multi-image TIFF file.  

It is important to realize that if you do not save the raw wavelength images, i.e., 

if you save only the ratio image, future analysis is impossible.   
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To save images as single-image TIFFs: 

!# Click the File... button on the right-hand side of the GenePix Pro main 

window. 

!# Select Save Images. 

!# From the Save as type field, select Single-image TIFF Files. 

!# Click the check boxes to select the images to save. 

!# Click the Save button. 

We recommend that for all data analysis purposes you save your images as 

multi-image TIFF files.  However, GenePix Pro also lets you export images in 

the JPEG format.  We recommend that you do not use the JPEG format to 

archive images; use it only for presentation purposes where image quantitation 

is not required. 

To export images as JPEGs: 

!# Click the File... button on the right-hand side of the GenePix Pro main 

window. 

!# Select Export Images. 

!# Enter a file name for your images. 

!# Click the check boxes to select the images to export. 

!# Click the Save button. 

Images saved in the JPEG format cannot be re-opened in GenePix Pro. 

Setting File Names 

GenePix Pro provides you with several options to generate file names 

automatically when saving images.   

To set automatic file names: 

!# Click the File... button on the right-hand side of the GenePix Pro main 

window. 
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!# Select Save Images. 

!# In the Naming group. 

!# Check the Date Prefix option to prefix the file name with the current 

date (YYYY-MM-DD).   

!# Check the Numeric Suffix option to add a four-digit suffix to the file 

name, where numbering begins at ‘0000’. 

!# Check the Barcode Prefix option to prefix the file name with any 

barcode symbols from your image. 

!# Check the User Name option to add the GenePix Pro user name to the 

front of a file name (you can set GenePix Pro to be opened by user 

name; see “Workflow Automation Options”). 

GenePix Pro controls the last few characters of the file name, which are reserved 

to indicate a file number, and the type of image if separate image files are being 

created.  When saving single-wavelength images as either TIFFs or JPEGs, 

GenePix Pro adds the wavelength of the image as a suffix to the file name.  

Image Analysis 
Once an image has been acquired, the next step is to view the image and measure 

the signal intensity of each feature.   

Selecting a Color Mode 

GenePix Pro 6.0 can be launched in two different modes, for two-color analysis or 

four-color analysis.  In two-color mode, you can load two single-wavelength 

images and define one ratio.  In four-color mode, you can load up to four single-

wavelength images, and define up to three independent ratios. 

To change color mode: 

!# Click the Options button on the right-hand side of the GenePix 

Pro main window. 
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!# Click the Display tab. 

!# To run in four-color mode, check the Four-color mode box. 

!# To run in two-color mode, uncheck the Four-color mode box. 

To change color mode, you have to shut down GenePix Pro and restart it. 

Opening an Image 

If you have just acquired an image, it will be displayed on the screen ready for you 

to analyze it.  (If you want to save an image that has just been scanned, be sure to 

do so before proceeding with analysis.)  Alternatively, you can open a previously 

saved image or one of the sample images provided on the GenePix Pro CD. 

To open an image: 

!# Click the File... button on the right-hand side of the GenePix Pro main window. 

!# Select Open Images. 

!# Navigate to a directory that contains previously saved TIFF images.  For 

example, open one of the sample TIFF files in the “Axon\Data” directory. 

!# Select the images and click the Open button. 

Opening Images in Four-color Mode 

To produce a sensible ratio image, images must be acquired with the same Scan 

Area (i.e., with the same Settings file) and at the same resolution. 

To open three or four images in four-color mode: 

!# Start GenePix Pro in four-color mode. 

!# Click the File... button on the right-hand side of the GenePix Pro main 

window. 

!# Select Open Images. 
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!# Navigate to a directory that contains previously saved TIFF images.  For 

example, open one of the sample TIFF files found in the “Axon\Data” 

directory. 

!# Hold down the %Ctrl& key to select multiple images. 

!# Click the Open button. 

!# GenePix Pro displays the Assign Image dialog box.  For each image, assign 

a wavelength and a color. 

If the images were acquired on GenePix scanner, GenePix Pro will automatically 

recognize the wavelengths used for each channel.  You can avoid the Assign Images 

dialog box by clicking off the Enable User Assigned Wavelengths and Channels 

checkbox in the Open Image/Options dialog box.  You can also override the actual 

values (for example to do ratio analysis of two images both scanned with the red 

laser) by clicking on the checkbox and entering any wavelength values you choose. 

Registering Images 

Images acquired from more than one scanner, or acquired sequentially (instead of 

simultaneously) may need to be registered (aligned) before they can be analyzed.  

If images are misregistered, you can register them by hand, or allow GenePix Pro to 

register them automatically. 

To register automatically: 

!# Click the Image Tools button on the Image tab. 

!# If your images are very badly misregistered, say greater than 10 pixels, you 

will need to set a starting offset for the registration algorithm.  

!# Click OK. 

!# If the registration fails, perform it again, but specify starting offsets. 

To register manually: 

!# Zoom in to the image so that you can see one or two features only. 

!# Click the Image Tools button on the Image tab. 
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!# Click Register 635 to 532. 

!# The cursor on the image is now a hand, and you can drag the red image 

relative to the green image.  Move the red image until it is aligned with the 

green image. 

!# Click the green button at the top of the image to accept the changes. 

In four-color mode, the procedure is similar, except that you must choose a Base 

Wavelength (i.e., the image to which the others are being aligned) and specify three 

sets of offsets.   

Rotating Images 

GenePix Pro 6.0 supports image rotation in 90-degree steps.  To rotate an image: 

!# Click the Image Tools button on the Image tab. 

!# Select one of the Rotate commands to rotate the specified number of 

degrees. 

!# After rotating an image you may wish to save it using the Save Images 

command under the File menu on the right-hand side of the GenePix Pro 

main window. 

Customizing Ratio Formulation 

The ratio formulation specifies which image is the numerator and which is the 

denominator for each ratio image.  In two-color mode this is a simple binary choice, 

but in four-color mode there are many more choices. 

For example, if you have four images numbered 1 to 4, your ratio images could be 

1/2, 1/3 and 1/4, or they could be 1/2, 2/3 and 3/4, which is a very different 

experiment. 

To change the ratio formulation: 

!# Click the Options button on the right-hand side of the GenePix Pro main 

window. 
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!# Click the Analysis tab. 

!# Click the Select button in the Ratio Formulation group. 

!# In two-color mode, switch to the reciprocal ratio formulation. 

!# In four-color mode, check up to three ratios. 

In four-color mode it is possible to select a set of ratios where one of the ratios can 

be expressed as a product of the others.  This is known as a dependent set of ratios, 

and the set cannot be normalized.  For example, 1/2, 2/3, and 3/1 is a dependent set.  

If you want to be able to normalize your data, use an independent set of ratios, such 

as 2/1, 3/1, 4/1. 

Image Display and Color Control 

GenePix Pro has many commands with which you can change the display of the image.   

To switch between single-wavelength and ratio images: 

!# Click the image name buttons in the Image group at the top left of the 

Image tab, or use the Hot Keys %Alt+W& or %Alt+Shift+W& to display the 

next or previous image in the list, respectively. 

To change the single-wavelength and ratio colors: 

!# Click the Color button in the Tools group on the Image tab. 

!# Select from the list of wavelength color combinations at the top of the 

menu. 

These image display controls are also available in real time during an acquisition.  

It is worth experimenting a little with the various display settings to find those with 

which you are most comfortable.  For example, green–blue with inverted color is 

good for distinguishing features from background at high magnifications. 

To invert colors: 

!# Click the Color button in the Tools group on the Image tab; 

!# Select Invert Color from the menu. 
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To change the brightness and contrast of the image: 

!# Click the Auto Scale Display Settings    button to set brightness and 

contrast to their optimum settings; 

!# Move the individual brightness  and contrast  sliders for custom settings. 

!# Click the Reset   button to return brightness and contrast to their defaults. 

Zooming the Display 

GenePix Pro has several sophisticated controls for magnifying an image. 

To increase the magnification of the image being displayed: 

!# Select Zoom Mode from the Tools group on the left-hand side of the Image 

tab, or use the Hot Key %Z&. 

!# Draw a rectangle around the area that you would like to view at higher 

magnification.   

To return to the previous magnification: 

!# Click the Undo Zoom button from the Tools group on the left-hand side of 

the Image tab.   

To view the image at full magnification: 

!# Click the Full Scale button on from the Tools group on the 

left-hand side of the Image tab, or use the Hot Key %Alt+F&.   

Using the Navigation Window 

The Navigation window displays a greatly reduced image of the entire scanned area 

with the current zoomed area bounded by a resizable Navigation region.  

To move around the image using the Navigation window: 

!# Zoom in to a region of the image using the Zoom tool. 

!# Click the Navigation window button in the Tools group on the 
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left-hand side of the Image tab. 

Hold down the mouse cursor in the Navigation region of the Navigation window, 

and drag it to the part of the image that you want to see. 

To zoom with the Navigation window: 

!# Click the Navigation window button in the Tools group on the left-hand 

side of the Image tab. 

!# Place the mouse cursor over a corner of the Navigation region until it turns 

into a four-way arrow cursor. 

!# Drag the corner in or out to zoom in or zoom out on the image. 

Using the Feature Viewer 

The Feature Viewer is at the left of the Image tab.  It displays a zoomed view of the 

image that is currently under the mouse cursor.  It also reports important information 

about each feature, such as the (x, y) coordinates of the cursor, and various ratio and 

intensity values.   

Once an analysis array has been created (see the next section, “Creating and Using 

an Analysis Array”), when the mouse is placed over a feature-indicator the Feature 

Viewer reports the intensity of the pixels within the feature-indicator, its associated 

background intensity level, the precise location of the feature-indicator in the 

analysis array, and substance IDs or names that have been defined for each feature. 

To change the magnification of the Feature Viewer: 

!# Click the Options button on the right-hand side of the GenePix Pro main 

window. 

!# Click the Display tab. 

!# Change the Field of View field to the new value. 

To hide feature indicators in the Feature Viewer display: 

!# Click the Options button on the right-hand side of the GenePix Pro main 

window. 
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!# Click the Display tab 

!# Uncheck the Show feature-indicators box and click OK. 

To undock the Feature Viewer in four-color mode: 

!# Start GenePix Pro 6.0 in four-color mode. 

!# Click the Options button on the right-hand side of the GenePix Pro main 

window. 

!# Click the Display tab. 

!# Uncheck the Docked check box, and click OK. 

Creating and Using an Analysis Array 

In order to measure the intensity of individual features you must create an analysis 

array, which defines the dimensions and location of each feature.  A detailed 

discussion of the algorithms used by the array can be found in Chapter 3.   

Spots, Features, Blocks and Arrays 

In GenePix Pro each individual spot that is deposited on a slide is assigned a 

feature-indicator.  A grid of feature-indicators is called a block.  There can be 

several blocks on a single array, depending upon the type and configuration of the 

arrayer that was used to place the spots on the slide.  Shown right is a small 

hypothetical 400-feature array, composed of four blocks, each with 100 features. 

Example 1:  Using a GAL File to Create Blocks 

GenePix Pro can automatically generate blocks using information that is 

contained in a GenePix Array List (GAL) file.  GAL files are used to link the 

information from the arraying process to the analysis.  They speed the analysis 

process and add a great deal to the data that are extracted from the array.  For 

example, when a GAL file is imported, the Feature Viewer reports the 

substance ID or name associated with a feature when the mouse is placed over 

it, and an Analysis operation exports these names to the Results tab together 

with all other extracted data.   
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To create blocks from a GAL file for the demo 

images: 

Collection of 100 
features (10 x10) in a 
single block 

Collection of 4 blocks

Microarray slide

!# Click the File... button on the right-

hand side of the GenePix Pro main 

window. 

!# Select the Load Array List command. 

!# Select “demo.gal”, the demo GAL file.   

!# Click Open. 

This procedure automatically creates blocks, 

and assigns substance names and identifiers (if 

they are in the GAL file) to each spot.   
Figure 2.  Hypothetical array of blocks. 

To create a new GAL file for a real slide, see “Importing Clone Information” on 

the following page. 

Example 2:  Manual Block Creation 

To create blocks manually: 

!# Click the New Blocks button in the Tools group on the 

left-hand side of the Image tab.   

!# In the Blocks group at the top of the dialog box, enter the number of 

blocks that you would like to use by specifying the number of rows and 

columns of the array of blocks.  For example, to create a 4 / 4 array of 

blocks, enter 4 for the number of columns and 4 for the number of 

rows. 

!# To determine the position of the blocks, specify the distance between 

them (see Figure 3).  If you do not have these distances from your array 

manufacturer or spotter, you can measure these distances directly from 

the array image using the X and Y coordinates reported in the Feature 

Viewer. 
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!# Specify the layout of the individual feature-indicators in each block 

(see Figure 3).   

Don’t worry too much about initially getting the spacing precisely correct.  You 

can quickly adjust the spacing by stretching the block corners with the mouse, 

or by using the equivalent keyboard shortcuts.  

Block spacing

Column spacing

Row spacing

Feature-indicator spacing

Column separation

Row 

separation

Column spacing

Row

spacing

Figure 3.  Block and feature-indicator spacing. 

Example 3:  Manual Block Creation in Replicate Mode 

Instead of creating a full array of blocks, it sometimes easier to create one block 

and then copy it. 

To use Replicate Block mode: 

!# Create a single block using the New Blocks dialog box as described on 

the previous page.   

!# Select Replicate Mode  from Tools group on the left-hand side of 

the Image tab.   

!# Click on the top left feature of each block of features, and a block is 

created wherever you click. 

Importing Clone Information 

In GenePix Pro clone information, such as substance IDs and names, is imported 

using a GenePix Array List (GAL file), which also creates blocks.  You can create 
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GAL files in several different ways.  Some arrayer software writes out GAL files 

with clone information.  If you are buying slides from your array manufacturer, 

they will supply you with a GAL file for the array. 

Example 1:  Creating a GAL File from Current Settings 

If you create a GAL file in this way, you need to add substance IDs and names 

manually in a spreadsheet such as Microsoft Excel. 

To create a GAL file from your current analysis (block) settings: 

!# Create blocks as described previously. 

!# Click the File... button from the right-hand side of the GenePix Pro 

main window. 

!# Select Save Settings As. 

!# From the Save as type list, select GenePix Array List Files. 

!# Click Save. 

Example 2:  Creating a GAL File with the Array List Generator 

The GenePix Array List Generator converts plain text files or ATF files 

containing substance names and IDs into GenePix Array List (GAL) files.  The 

Array List Generator is specifically designed to make GAL file creation simple.  

It checks and validates GAL files for you, and it previews the array of blocks 

defined by your GAL file.  From the Array List Generator you can also open 

the Well Converter, with which you can convert four 96-well plate files into a 

384-well plate file.  See “Creating and Aligning Blocks and Feature-Indicators” 

in Chapter 3 for the types of arrays to which the Array List Generator applies. 

When GenePix Pro is installed, several sample 384-well plate and 96-well plate 

files are copied to your ...\Axon\Params directory so that you can learn how to 

use the Array List Generator and Well Converter.  You may want to open one 

of the “384 Plate…” text files with a text editor such as Notepad to see the file 

format for yourself:  it is simply contains the row and column indices, and 

names, for each of the wells on a plate. 
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To create a GAL file with the Array List Generator from the sample text files: 

!# Click the Array List Generator button on the right-

hand side of the GenePix Pro main window. 

!# Click the Add button.  

!# If you have 96-well plate files, use the Well Converter to convert them into 

384-well plate files.  Open the Well Converter from its button in the Array 

List Generator.  Well Converter is explained fully in the on-line Help. 

!# GAL files can also be opened and edited in Microsoft Excel to make 

minor additions or other modifications. 

Aligning Blocks on an Image 

GenePix Pro uses three sets of alignment algorithms:  one for finding the entire 

array of features, one for finding the location of complete blocks of feature-

indicators on an image, and one for aligning the feature-indicators within the blocks 

with features on the image. 

Find Array pre-positions the whole array of blocks over the array on the image. 

Find Blocks places each block in its optimal starting position for the 

alignment of features, and it estimates rotation and skew, and row and 

column separation for each block.  It does not move individual feature-

indicators within blocks.   

Align Features, which aligns each feature-indicator with the nearest feature, works 

best when the initial position of a block satisfies the following two criteria: 

!# each feature-indicator partially overlaps its associated feature (e.g., about 

half a feature-indicator diameter overlap); 

!# the feature-indicator diameter is slightly smaller than the average feature 

diameter. 

The combination of these three procedures is highly robust and reliable, so we 

recommend using the global command Find Array, Find All Blocks, Align 

Features, or the hot key <F8>. 
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If your slide has features with a range of sizes, you can change the maximum and 

minimum diameters used by the spot-finding algorithm: 

!# Click the Options button on the right-hand side of the GenePix Pro main window. 

!# Click the Alignment tab. 

!# Enter the Min diameter and Max diameter as percentages of the starting 

diameter of each feature.   

You can disable diameter-resizing altogether during Auto Aligns by unchecking the 

Resize features during alignment check box.   

Once an automatic alignment is completed, you may need to review block and 

feature positions and make some manual adjustments.  To operate on blocks 

manually you need to be in Block mode (Hot Key %B&). 

Non-circular Feature-indicators 

GenePix Pro supports square and irregular feature-indicators, as well as the default 

circular feature indicators.  To use this feature: 

!# Open the Options / Alignment dialog box. 

!# Select Find Square Features or Find Irregular Features. 

If you are using irregular features, you can choose to fill in holes in features, or find 

the holes as well.  To use this option: 

!# Open the Options / Alignment dialog box. 

!# To find holes in irregular features, uncheck the Fill Irregular Features option. 

If you use irregular features, after analysis you can use the Circularity column in the 

Results tab as a quality control measure on your features.  Circularity ranges from  

0 (non-circular) to 100 (circular).  Squares features are always given a value of  

79 (100 × 0/4). 
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Zooming in on Blocks 

While you can use the Zoom Area tool for zooming, GenePix Pro has several 

special zooming functions for use with blocks.   

To use these special functions: 

1 2

3 4

5

!# Select a single block.   

!# Use %1& to zoom in to the top left quadrant of 

the selected block. 

!# Use %2& to zoom in to the top right corner. 

!# Use %3& to zoom in to the bottom left corner. 

!# Use %4& to zoom in to the bottom right corner. 
Figure 4.  Zooming Hot Keys. 

!# Use %5& to zoom in to and center the whole 

block. 

!# Use %>& and %<& to zoom in to the next or previous block.   

Once you have zoomed the block so that you can see the location of feature-

indicators and how well they align with features in the image, you can move the 

block either by dragging it using the mouse, or with the arrow keys on the 

keyboard. 

Moving and Resizing Blocks 

Although the mouse is useful for quick and crude moving and resizing of blocks, 

for fine positioning it is often more efficient to use the keyboard controls: 

!# Select a single block. 

!# To move the block, use the arrow keys. 

!# To resize the block, use %Ctrl&+arrow keys. 

Rotating Blocks 

With a block selected, you can rotate it 0.1 degrees at a time with the %+& and %–& keys. 
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Manually Moving, Resizing, and Fine-tuning Feature-indicators 

After an Align Blocks, you may want to fine-tune some of the feature positions 

manually.  For example, it may be necessary to align manually features that are 

flagged Not Found by Align Blocks.  This is easily accomplished using Feature 

Mode.   

After selecting Feature Mode click on one, or many, feature-indicators that you 

would like to move or resize, and they are highlighted.   

Feature mode has two sub-modes, rectangle and lasso, for making multiple 

selections.  Once you are in Feature mode, click the Feature mode button again to 

display a choice of rectangle or lasso: 

!# In Rectangle mode, if you hold down the mouse and drag it, every feature 

in the bounding rectangle of the region is selected. 

!# In Lasso mode, hold down the mouse and draw an arbitrary closed region 

to select all the features in the region. 

Feature selection also works when the blocks are defined by not displayed.  You 

may find it easier to select irregular regions in lasso mode when the blocks are not 

displayed, as the image is more visible. 

Use the arrow keys to move or resize them (these keys are also listed in the right 

mouse menu in Feature Mode): 

!# Select a feature or features. 

!# To move the feature(s), use the arrow keys. 

!# To resize the feature(s), use %Ctrl&+arrow keys or %Ctrl&+mouse wheel. 

If you re-size or move an irregular feature-indicator then it is reset to circular.  The 

diameters of feature-indicators are reported in the Results spreadsheet; for non-circular 

features, the diameter reported is the diameter of the circle of best fit.  Irregular features 

also have a measure of circularity reported in the Circularity column, where 100 is 

circular and 0 is most non-circular.  Feature-indicators should fit closely around 

features.  Features that cut the boundary are not included. 
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Note:  Feature Indicators cannot be moved or resized if the settings are Locked (see 

Section “Linkage”). 

Quick Zooms 

In Feature mode there are Quick Zoom hot keys that are similar to the Block mode 

Hot Keys: 

!# %Alt&+arrow keys: select previous or next feature; 

!# %[ & or %]&: move cursor to previous or next selected feature; 

!# %0& (zero): zoom and center current selected feature. 

If images and Results are linked (see “Linkage” Section), then the %0& Hot Key on 

the Results or Scatter Plot tab switches the display to the Image tab: 

!# If a feature is highlighted on the Results tab, pressing %0& zooms to it on the 

Image tab. 

!# If a feature is under the mouse cursor on the Scatter Plot tab, %0& zooms to it 

on the Image tab. 

Flagging Feature-indicators 

GenePix Pro provides the ability to mark or flag individual feature-indicators.  For 

example, you may find some features should be ignored during your final analysis 

because of imperfections on the array.   

To flag a feature on the Image tab: 

!# Select Feature mode from the Tools group on the left-hand 

side of the Image tab. 

!# Select the feature to flag by clicking it. 

!# Click the Feature button on the right-hand side of the GenePix Pro main 

window, or bring up the right mouse menu on the feature. 

!# Select a flag to apply to the feature—Good, Bad, Not Found or Absent.   
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GenePix Pro also flags features automatically: 

!# If Align Blocks fails to find a feature, the feature is flagged Not Found.  

!# If there are blank entries in the active GAL file, the corresponding features 

are flagged Absent.   

All flags are stored in the final Results table and are exported with numerical 

equivalents:  

!# Good is given the value 100. 

!# Bad is given the value –100. 

!# Not Found is –50. 

!# Absent is –75. 

!# Unflagged is 0. 

See “Defining Your Own Flag Criteria” Section, for advanced feature-flagging 

techniques. 

Note:  Feature Flags cannot be removed or added if settings are Locked  

(see “Linkage” Section). 

Resetting Flags and Positions 

To remove the flags or nudges from feature-indicators: 

!# Select Feature mode from the Tools group on the left-hand side of the 

Image tab. 

!# Select the features to reset by clicking them, or by dragging a region around 

them. 

!# Click the Feature button on the right-hand side of the GenePix Pro main 

window, or bring up the right mouse menu on the feature. 

!# Select the command to apply:  Clear Nudges, Clear Flags, or Clear Flags 

Except Absent. 
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Saving the Positions of Blocks and Feature-indicators 

After you have finished aligning your analysis array, it is important to save its 

configuration: 

!# Click the File..button on the right hand side of the GenePix Pro main 

window.   

!# Select Save Settings As from the menu. 

!# Enter a file name for the settings and click OK. 

When you save the settings, you not only save the position of the array, but you 

also save any acquisition settings you may have made such as the size and position 

of the scan region, and any display settings such as contrast and brightness. 

Locking Settings 

Once you have aligned the feature-indicators and applied any quality flags, you 

may want to lock your settings to prevent you from accidentally changing them 

after the Results have been calculated (see “Linkage” Section.)   

To Lock Settings: 

!# Click the Lock Settings button from Tools group on 

the left-hand side of the Image tab.  

When settings are locked, you cannot move blocks or feature-indicators, and 

several other commands (such as Align Blocks and Align Images) are disabled.   

You can set the Locking default to Lock Settings automatically after an Analyze 

command: 

!# Click the Options button on the right-hand side of the GenePix Pro main 

window. 

!# Click the Workflow tab. 

!# Check the Lock settings after analysis check box. 
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You can manually lock and unlock the settings any time by clicking the Lock 

Settings button.  Any change you make to your feature settings breaks their linkage 

with downstream results.  To re-establish linkage, Analyze again. 

Customizing Background Subtraction 

GenePix Pro offers the choice of several background subtraction methods.  By 

default, GenePix Pro uses a local background subtraction method (see “Computing 

Background Intensities” in Chapter 3).  This is the recommended method, as it 

much more responsive to background intensity variations across a slide.  However, 

GenePix Pro does offer global methods, in which a single background value is used 

for each channel, for the whole slide. 

To change the background subtraction method: 

!# Click the Options button on the right-hand side of the GenePix Pro main 

window. 

!# Click the Analysis tab. 

!# Click the Select button in the Background Subtraction group. 

!# Select a new background subtraction method. 

Performing the Analysis and Viewing the Results 

After aligning the analysis array, perform the analysis by pressing the 

Analyze button.  The analysis extracts data from the single-wavelength 

images in each feature-indicator, and the results and subsequent 

computations are sent to the Results tab spreadsheet.   

After the analysis a JPEG file of the image is saved and used in the Feature Viewer 

in the Results and Scatter Plot tabs.  The image is saved with the brightness, 

contrast and color settings at the time of the analysis.   

To save a JPEG to be used in the Feature Viewer with saved Results: 

!# Click the File... button on the right-hand side of the GenePix Pro main 

window. 
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!# Click Save Results As. 

!# Check the Save a JPEG image check box. 

!# Click Save. 

Using the Results Spreadsheet 

In addition to the basic raw data and derived ratio measurements, the Results 

spreadsheet shows the location of each feature-indicator, substance information 

from the GAL file (such as substance names and ID), and any flags that were on the 

image before the analysis. 

To sort the data in the spreadsheet, click on a column title.  Click the same column 

title again to sort the data in the reverse order.   

To group several discontinuous rows together: 

!# Select the rows by holding down the %Ctrl& key and clicking the rows. 

!# Press the Group Rows button.   

To reorder columns: 

!# Click on a column title and drag it to a new position in the spreadsheet. 

Alternatively: 

!# Click on the Data Types button in the Table group on the left-hand side of 

the Results tab.  

!# You can customize two different views of the spreadsheet.  Select Custom 1 

or Custom 2, then select the Data Types you want in that view. 

!# Reorder columns by clicking the up and down arrows.  For accelerated 

movement, hold down the button. 

!# Show and hide columns by moving them between the Available Data Types 

and Visible Data Types fields with the horizontal arrows.  Note that grayed-

out column names have no data in the active Results table, and are not 

displayed in the Results spreadsheet until they do have data. 
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!# Click Restore to Default to display the standard GenePix Pro default of all 

applicable columns. 

To show and hide rows based on their flags: 

!# Click the Display button in the Table group on the left-hand side of the 

Results tab.   

!# Check the flag types to display.  For example, to show only features that are 

included in normalization, uncheck all the boxes in the Excluded column. 

Note that settings in the Display dialog box do not change the underlying data set.  

A GPR file always contains the entire data set.  To save results with a customized 

set of Data Types, choose Export Results from the File... menu.  

Linkage 

After an analysis your images, settings, and Results are linked, shown by the message 

“Ready – Linked” in the Status Bar at the bottom left of the GenePix Pro main window. 

Linkage is the state of having the current Results match the current image and 

settings; i.e., if you re-analyze you get exactly the same results.  When linked, you 

can flag or select in any feature-viewing tab and the others are updated accordingly. 

“Locking” prevents your data from becoming unlinked.  

To flag a feature on the Image tab, Results tab and Scatter Plot tab simultaneously: 

!# Ensure that “Linked” is displayed in the Status Bar at the bottom of the 

GenePix Pro main window. 

!# Select features on the Image tab, Results tab or Scatter Plot tab.  

!# Select a flag command from the right mouse menu, or from the Feature menu. 

To navigate from the Results tab to the same feature on the Image tab when linked: 

!# Check that “Ready – Linked” is displayed in the Status Bar at the bottom 

left of the GenePix Pro main window. 

!# Click on the row of interest in the Results tab. 
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!# Press the %0& Hot Key. 

Results and images that are saved when linked can be opened all together simply by 

opening the Results file.  GenePix Pro automatically locates and opens the 

corresponding image files. 

To open linked images and Results: 

!# Click the File... button on the right-hand side of the GenePix Pro main window. 

!# Select Open Results. 

!# Check the Open associated images and Recreate analysis settings check boxes. 

!# Click Open. 

If images and settings are opened and linked successfully, the Status Bar message at 

the bottom of the GenePix Pro main window reports “Linked”. 

Web Interactivity 

GenePix Pro 6.0 is closely integrated with the web.  To look up a substance ID or 

name on a web database: 

!# Ensure that you have a GAL file or settings file loaded that contains 

substance names and IDs. 

!# Click the Options button on the right-hand side of the GenePix Pro main 

window. 

!# Click the Analysis tab.   

!# Select the address of a web database from the Web address list, or click 

Manage to enter a new web address. 

!# Click OK. 

!# Select a feature in the Image tab, Results tab or Scatter Plot tab. 

!# Click the right mouse menu and select Go To Web to open the database in 

your default web browser. 
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Normalization 

GenePix Pro 6.0 includes full normalization of images and data (see “Data 

Normalization” in Chapter 3).  If images and Results are linked, then both images 

and Results will be normalized; if they are not linked, only the Results will be 

normalized.  When linked, the GenePix Pro Status Bar reports “Linked”. 

Before you normalize, you must decide to normalize on control features only, or on 

all features, or you can choose to apply your own normalization factors to the images. 

To configure normalization so that you normalize on all features (excluding those 

flagged Bad, Absent and Not Found): 

!# Click the Configure button in the Normalization group on the left-hand side 

of the Results tab. 

!# Click the Ratio-based button at the top of the dialog box. 

!# From the mean of the list box, select a ratio type.  Typically, this is the 

main ratio value that you use for all your analyses. 

!# Select all of the features from the second list box. 

!# In the is equal to field, enter a ratio value.  By normalizing on all features, 

you are assuming that the mean ratio of all features on the array is equal to 

1, so enter 1 in this field. 

To configure normalization so that you normalize on selected features only:  

!# Flag features for normalization with an Include in Normalization flag.  See 

“Defining Your Own Flagging Criteria” Section. 

!# Click the Configure button in the Normalization group on the left-hand side 

of the Results tab. 

!# Click the Ratio-based button at the top of the dialog box. 

!# From the mean of the list box, select a ratio type.  Typically, this is the 

main ratio value that you use for all your analyses. 

!# Select the normalization features from the second list box. 
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!# In the is equal to field, enter a ratio value.  The value here depends on the 

expected behavior of your control features.  For example, if you expect 

your control features to have a ratio of 0.8, enter 0.8. 

To configure normalization so that you normalize with user-defined normalization 

factors: 

!# Click the Configure button in the Normalization group on the left-hand side 

of the Results tab. 

!# Click the User-defined button in the middle of the dialog box. 

!# Enter your own normalization factor for each image. 

With normalization configured, all that remains is to apply it to your Results and 

images.  You can do this by: 

!# Clicking Normalize within the Configure tab OR 

!# Clicking OK to exit from the Configure tab (this accepts your normalization 

configuration but does not apply it) and then click the Apply button in the 

Normalization group on the left-hand side of the Results tab.   

To remove normalization once it has been applied: 

!# Click the Remove button in the Normalization group on the left-hand side 

of the Results tab. 

If you normalize your Results and then save, your normalized Results are saved.  If 

you intend to do further analyses on your Results in GenePix Pro (for example, 

removing normalization and trying out different normalization methods), we 

recommend that you save your Results unnormalized. 

After Normalization, the status bar at the bottom of the GenePix Pro main window 

reads “(Un)Linked – Normalized”. 

Defining Your Own Flagging Criteria 

The Flag Features dialog box is an extremely powerful tool for flagging features by 

constructing general Boolean queries of Results tab data.  You can type or insert 
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VBScript expressions in the Query field and have them evaluated in the Results 

table.  You can also save commonly used queries, such as custom quality control or 

normalization conditions that you apply to every array. 

(Note:  In GenePix Pro 6.0, the Good flag value and the Bad flag value when 

applied from the Flag Features dialog box are different to the flag values when 

they are applied manually:  Good is 99 and Bad is –99.) 

A query typically consists of several conditions joined with the logical connectives 

AND or OR.  A row satisfies a query consisting of two conditions joined by an 

AND if it satisfies both conditions independently; it satisfies a query consisting of 

two conditions joined by an OR if it satisfies at least one condition. 

To construct a single condition, such as: 

[Ratio of Medians (635/532)]  > 1.5 

!# Click the Flag Features button in the Normalization group on the left-hand 

side of the Results tab. 

!# To begin a new query, click the New button on the right-hand side of the 

dialog box. 

!# From the Column list, select “Ratio of Medians (635/532)”. 

!# From the Operator list, select “>”. 

!# In the Value field, type “1.5”. 

!# Click the Add button to add the condition to the current query in the Query 

field. 

!# Click Evaluate to find the number of rows to which the condition applies. 

!# Click the Save As button to save the query. 

You can build this expression into a more complex query.  For example, to add the 

following condition: 

[Ratio of Medians (635/532)]  < 0.66 

!# Click the Or button. 
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!# From the Column list, select “Ratio of Medians (635/532)”. 

!# From the Operator list, select “<”. 

!# In the Value field, type “0.66”. 

!# Click the Add button to add the condition to the current query in the Query field. 

!# Click Evaluate to find the number of rows to which the condition applies. 

!# Click the Save button to save the query. 

The full expression now looks like: 

[Ratio of Medians (635/532)]  > 1.5 OR 

[Ratio of Medians (635/532)]  < 0.66 

Features are flagged on exiting the dialog box by clicking the OK button.  You can 

also choose to highlight the rows in the Results tab. 

To flag features in the Results tab which satisfy the query: 

!# Check the Flag check box in the Action group at the bottom of the dialog box. 

!# Select the type of flag to apply. 

!# Click OK. 

To highlight rows in the Results tab which satisfy the query: 

!# Check the Highlight Data check box in the Action group at the bottom of 

the dialog box. 

!# Select whether to Replace the current highlighted rows, or to Add to the 

current highlighted rows. 

!# Click OK. 

Using Flag Features for Complex Quality Control Queries 

You can use the Flag Features dialog box to construct arbitrarily complex quality 

control conditions on your features.   
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First, you need to decide on a set of quality control criteria.  For example, you might 

choose to exclude (i.e., flag Bad) any feature that satisfies the following criteria: 

!# the feature intensity is near background; 

!# the feature is not uniform; 

!# the background is not uniform. 

You need to be able to translate these conditions into symbolic expressions.  The 

first is relatively simple.  It can be expressed as: 

[% > B635+2SD] < 70 OR [% > B532+2SD] < 70 

This condition picks up features that do not have at least 70% of their feature pixels 

more than two standard deviations above background in either the green or the red 

channel.  You may want to experiment with the figure of 70% to find a figure that 

is diagnostic for your arrays. 

The second condition is a little trickier.  One way of measuring the non-uniformity 

of the feature is to compare any of the five ratio types reported by GenePix Pro, 

e.g., the ratio of medians and the regression ratio.  It can be expressed as: 

[Ratio of Medians (635/532)]  > (1.2*[Rgn Ratio (635/532)]) OR 

[Ratio of Medians (635/532)] < (0.8*[Rgn Ratio (635/532)]) 

This condition picks up features that have a ratio of medians greater than 1.2 or less 

than 0.8 times the regression ratio.  Again, you may want to experiment with these 

values of 1.2 and 0.8. 

Finally, to select features with a variable background, compare the mean and the 

median background levels: 

([B635 Mean]  > (1.2*[B635 Median]) OR 

([B532 Mean]  > (1.2*[B532 Median]) AND 

([B635 Median] > 40 OR [B532 Median]) > 40) 

This condition selects features that have a mean background greater than 1.2 times 

the median background at either wavelength.  It also includes a lower bound on the 
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absolute value of the background, as variation in a very low background level is not 

as significant as variation when the background is higher.  The condition picks out 

features that have bright pixels or smears in their backgrounds, or features with 

irregular shapes that do not fit the circular feature-indicators. 

Because a feature that fails any of these criteria is deemed to have failed overall, 

join each of the conditions by an OR to construct a single query: 

[% > B635+2SD] < 70 OR [% > B532+2SD] < 70 OR 

[Ratio of Medians (635/532)]  > (1.2*[Rgn Ratio (635/532)]) OR 

[Ratio of Medians (635/532)] < (0.8*[Rgn Ratio (635/532)]) OR 

(([B635 Mean]  > (1.2*[B635 Median]) OR 

[B532 Mean]  > (1.2*[B532 Median])) AND 

([B635 Median] > 40 OR [B532 Median] > 40)) 

You can continue to add conditions to this query.  For example, you may want to 

add checks for absolute feature intensity (i.e., features are flagged Bad if the Sum of 

Medians is not above a certain intensity) or absolute background intensity  

(i.e., features are flagged Bad if their backgrounds are above a certain intensity). 

Consult the “Flag Features” topic in the on-line Help for more information about 

using this dialog box. 

Saving and Exporting the Data 

Once the analysis has been completed, you should save your data. 

To save in the default GenePix Results (GPR) file format: 

!# Click the File... button on the right-hand side of the GenePix Pro main 

window. 

!# Select Save Results As. 

!# Enter a file name.  

!# From the group of Naming options, check the boxes to add prefixes and 

suffixes to the name. 
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!# Click OK. 

To ensure consistency among data to be stored in a database, data saved in the GPR 

format always contain the full set of columns, regardless of the current column 

display, or the color mode. 

To export only the current view of the Results, i.e., the columns in your customized 

view: 

!# Click the File... button on the right-hand side of the GenePix Pro main 

window. 

!# Select Export Results. 

!# Enter a file name.  

!# From the group of Naming options, check the boxes to add prefixes and 

suffixes to the name. 

!# Click OK. 

Note that exported Results are saved as plain text files (*.txt) and cannot be opened 

in GenePix Pro. 

To export only selected rows from the Results tab: 

!# Select the rows that you want to export.  Select contiguous groups of rows 

by holding down the %Shift& key when selecting; select discontiguous rows 

by holding down the %Ctrl& key when selecting.  To select all rows, use the 

%Ctrl+A& Hot Key. 

!# Press the Copy button on the right-hand side of the GenePix Pro main 

window, or use the %Ctrl+C& Hot Key. 

If the buttons for exporting the data are disabled, this is because you currently do 

not have a GenePix Pro security key attached to your computer.   

Scatter Plot 

Use the Scatter Plot tab to generate scatter plots of any two analysis data types for 

all spots on the array, or to draw a histogram of any one analysis data type. 
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To choose quantities plotted on each axis: 

!# Do an analysis or open a Results file. 

!# Switch to the Scatter Plot tab. 

!# From the X Axis group on the left-hand side of the Scatter Plot tab, choose a 

quantity to plot along the X Axis, e.g., Sum of Medians. 

!# From the Y Axis group on the left-hand side of the Scatter Plot tab, choose a 

quantity to plot along the Y Axis, e.g., Log Ratio. 

!# You can also specify the Scatter Plot axes directly from the Results tab by 

right-clicking on any column and choosing Set this data type as Scatter 

Plot X- (or Y-) axis. 

Position the mouse over any point on the Scatter Plot to display the associated 

feature in the Feature Viewer.   

The Scatter Plot and the Results spreadsheet are fully integrated:  select several 

features in one tab and when you switch to the other tab they are highlighted.  If 

images and Results are linked (see above Section “Linkage”), then selecting or 

highlighting features on the Scatter Plot tab selects or highlights them on all tabs. 

Some useful ways to display data:  

!# F1 Median vs. F2 Median:  the diagonal through the origin separates 

features with a higher activity than the reference from features with a lower 

activity than the reference.  If the data cloud lies significantly off the  

45-degree diagonal, it may indicate a significant difference in channel 

intensity that should be normalized.  

!# Index vs. Log Ratio:  the chosen ratio is displayed as greater or less than 

1.0 for all spots.  Differentially regulated features are more easily identified 

than on a standard intensity comparison plot. 

!# Sum of Medians (Log Axis) vs. Log Ratio:  highlights low intensity spots 

with artificially high ratios.  If the denominator of a ratio is very low, the 

resulting ratio value may be artificially high.  You can use this plot to 

identify such false outliers. 
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To flag features on the Scatter Plot: 

!# Click and drag the cursor to select a group of data points.   

!# From the right mouse menu, or from the Feature menu on the right-hand 

side of the GenePix Pro main window, select a Flag command. 

To show or hide flagged features: 

!# Click the Display button in the Display group on the left-hand side of the 

Scatter Plot. 

!# Check the types of flagged features to display. 

To show or hide analysis lines (regression line, k-standard error lines): 

!# Check the Analysis Lines box 

To configure analysis lines: 

!# Click the Configure… button in the Display group on the left-hand side of 

the Scatter Plot. 

!# Check which lines to display from:  Regression Line; k-standard deviation 

lines. 

To draw a histogram: 

!# Select Histogram from the Visualization list on the Scatter Plot tab. 

!# Select a data type from the X Axis list. 

Report Tab and Scripting 

The Report tab is an embedded Internet Explorer window, so it has all the scripting 

functionality of that program:  scripts can be written in VBScript, JavaScript, or any 

other scripting language supported by Internet Explorer (such as PerlScript or Python).   

The Report tab includes ready-to-use Reports for scanner performance validation 

and analysis.  It enables full scripting of all GenePix Pro acquisition and analysis 

functions.  To demonstrate some of the functionality and power of the GenePix Pro 
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Report tab, several example Reports are installed with the program.  These are 

always available from the Report tab by clicking the Home button. 

To use any of the Reports: 

!# Switch to the Report tab. 

!# Click the Report that you want to run and follow its instructions. 

The Analysis Reports are ready to use for advanced data analysis.  The Hardware 

Diagnostic Reports include tools for GenePix scanner performance validation.  The 

Example Reports demonstrate how to use some properties and methods of the 

GenePix Pro Object Model.  Any of these can be customized directly in GenePix 

Pro by clicking the Edit button on the left-hand side of the Report tab.   

The GenePix Pro on-line Help (press %F1&) includes an extensive scripting tutorial 

in which the GenePix Pro Object Model is documented.  

Special Functions 
The following is a description of other features of GenePix Pro that you may use 

regularly.  

Measuring Tools 

When you want to measure pixel values in an arbitrary line or area on an image, use 

the Measuring Tools provided in GenePix Pro.  With these tools, you can create 

your own data measurement regions, including line profiles, multiple line-segment 

profiles, rectangular averaged lines, and rectangular, elliptical and polygonal areas. 

To use the Measuring Tools: 

Measuring 
  Tools 

!# Click the Measuring Tools button from the Tools group on the 

left-hand side of the Image tab. 

!# Select the tool you want from the popup menu. 

!# Using the mouse pointer as a drawing tool, create a measuring region on the 

image. 
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The use of each tool is fully explained in the on-line Help.  You can create multiple 

measuring regions on one image, and move and resize them like blocks and 

features.   

The information about the selected region is automatically displayed in the 

Measuring Tools Properties window, including a graph of pixel intensity data for 

each wavelength.  

To hide or show the Measuring Tools Properties window: 

View 
Measuring 

Tools 

!# Click the View Measuring Tools button from the Tools group 

on the left-hand side of the Image tab: 

Pixel Plot 

Use the Pixel Plot to evaluate individual features in more detail.   

To view the Pixel Plot: 

!# Go to the Image tab. 

!# Open an image and place blocks on the image. 

!# Position the mouse over a feature-indicator. 

!# Press the %P& Hot Key, or in Feature mode select Pixel Plot from the right-

mouse menu, or from the Feature menu on the right-hand side of the 

GenePix Pro main window. 

The Pixel Plot graphs the distribution of the pixels within the selected feature-

indicator.   

To see the distribution of feature pixels and background pixels for the feature: 

!# In the Items to Plot group, check the Feature Pixels and Background Pixels 

check boxes, and uncheck the Regression Pixels check box. 

!# The pixels are plotted as points on the graph, with background pixels black 

and feature pixels yellow. 
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To see the difference between the Ratio of Medians and the Regression ratio for the 

feature: 

!# In the Items to Plot group, check the Ratio of Medians and Regression 

Ratio check boxes, and uncheck the Median of Ratios check box. 

!# The ratios are plotted as lines through the points, with the Ratio of Medians 

red and the Regression Ratio blue. 

The Pixel Plot also shows derived ratio measurements, so you can see the 

relationship between ratio and pixel values.  The derivation of all ratio 

measurements is discussed in further detail in Chapter 3. 

Histogram 

The Histogram displays the distribution of pixels for each raw wavelength image.  

The display color-codes each distribution according to the ratio colors used to 

create the ratio image; i.e., if the first channel is displayed in red on the Image tab, 

its trace on the Histogram is drawn in red.   

The Histogram is derived from the current view of the image in the Image tab, so if 

you have zoomed in on part of an image, only those pixels currently displayed are 

used to construct the Histogram. 

To see the Histogram for the entire image: 

!# Go to the Image tab. 

!# If you are zoomed in to a part of the image, press Zoom Full Scale to see 

the whole image. 

!# Select Zoom mode from the Tools group on the left-hand side of the Image tab. 

!# Draw a zoom area tightly around the features on the image to exclude as 

much background as possible. 

!# Switch to the Histogram tab. 

To use the Histogram to see how many pixels are saturating: 

!# Press Full Scale in the X Axis group on the left-hand side of the Histogram tab. 
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!# Zoom in on the far right edge of the histogram, by holding down the mouse 

cursor and dragging it along the X axis between 60000 and 65000. 

!# The proportion of saturated pixels is plotted at 65535. 

The Histogram is also useful for checking the balance of the PMT settings for each 

of the lasers.  For example, if the peak of the red trace is significantly shifted to the 

right of the peak of the green trace, this suggests that you may need to increase the 

PMT settings for the green channel (see above Section “Optimizing Hardware 

Settings”), or normalize your Results (see above Section “Normalization”). 

Batch Analysis Tab 

Use the Batch Analysis tab to do spot finding and analysis on batches of images. 

1.  Select images and GAL/GPS files to process 

The first step in setting up a Batch Analysis is to select the images to process. 

Adding files to the list 

Click the Add button to select images and a GAL or GPS file for the batch.  

You can use a single GAL/GPS file for the whole batch, or different files: 

!# To use a single GAL/GPS file, select a batch of images and only one 

GAL/GPS file in the Add dialog. 

!# To use different GAL/GPS files for different images, select the images with 

the Add command, and then select each image in turn from the Batch 

Analysis list, and use Select GAL or Select GPS to apply a GAL/GPS to 

that file only. 

When a GAL/GPS file is selected, it is listed in the "Initial GAL or GPS" 

column. 

File names of generated files 

When images are added to the Batch Analysis list, the GPS and GPR file names 

of the files that will be generated from the Batch Analysis are listed in the 

"Aligned Settings (GPS)" and "Results (GPR)" columns. 
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Note:  Batch Analysis never overwrites existing GPS or GPR files:  generated 

file names are always unique in the directory in which they are saved. 

Generated files location 

GPS and GPR files generated by Batch Analysis are by default saved in the 

same directory as the images.  

However, you can also specify a different directory.  To do this, select Use 

folder options and then configure the directory using Options / Folders.   

Single-image TIFF files 

If you have pairs of single-image TIFF files, then you need specify how they 

are to be paired, typically by a file name suffix. GenePix Pro recognizes a 

number of common file name suffixes (e.g., "_635" and "_532") or you can add 

your own in Options / Batch Analysis. 

2.  Align and Analyze 

You can align features in a batch in one of two different ways, depending on 

how you want to review the results: 

!# Align one image at a time, and review the results at the end of each 

image alignment:  use Process Next. 

!# Align all images, then review all images:  use Align All. 

When the alignment is finished, whether it is one array or a whole batch, use 

the Batch Review dialog box to review the results: 

!# If you are aligning one image at a time, you can inspect the generated 

settings on the Image tab, edit them as required, save settings, and then 

click the Align Next button. 

!# If you have aligned a whole batch, you can step through each image in 

the batch by clicking the Open Next button. 
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Find Array (Recommended) 

From the Batch Analysis tab, alignment is always Find Array, Find All Blocks, 

Align Features <F8>.  

The only known case in which <F8> may possibly fail is when an image has a 

bright barcode in which the dimmest part of the barcode (generally the bars) is 

brighter than the brightest part of the image.  In such a case, the Find Array 

algorithm may find the barcode instead of the features on the image.  In such a 

case you should skip the Find Array part of the algorithm.  For the rest of the 

spot finding to proceed successfully, the starting position of the blocks should 

overlap the blocks on the image. 

Analyze 

Select the Analyze option to analyze images and generate GPR files after the 

spot finding has finished. 

Run this flag features query 

After each GPR file is generated you can run a saved Flag Features query, to 

perform some primary quality control flagging on the generated GPR file. 

Workflow Automation Options 

GenePix Pro 6.0 includes several options designed to automate routine 

tasks.  The most obvious of these is the Preview Scan then Data Scan 

button.  If you are content to scan a whole slide, or if you are confident 

about the placing of your scan area, you can press this button and 

perform the two scans consecutively. 

To set other Workflow options: 

!# Click on the Options button on the right-hand side of the GenePix Pro main 

window. 

!# Click the Workflow tab. 

!# In the Automatically group, check any of the options that you want to use to 

automate acquisition or analysis. 
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To configure GenePix Pro so that each user has a user name with which they log in 

to GenePix Pro: 

!# Click on the Options button on the right-hand side of the GenePix Pro main 

window. 

!# Click the Workflow tab. 

!# Check the User Identification check box.   

All GenePix Pro settings are saved on a per-user basis.   

Workflow options are useful on their own, but become particularly powerful when 

used together with scripting in the Report tab. 

Find 

Use the Find command to find substance names and/or IDs anywhere in GenePix 

Pro.  

To search for substance names or IDs in the Image tab: 

!# Switch to the Image tab. 

!# Click the Find button on the right-hand side of the GenePix Pro main 

window.  

!# Check the Feature Names and Feature IDs check boxes. 

!# Enter the Name or ID to search for in the Containing Text field. 

!# Check the boxes next to any other options that you might require, such as 

Exact match or Case sensitive. 

!# Click OK. 

In the Image tab, Find highlights features that have the name or ID specified and 

snaps the cursor to the feature.  In the Lab Book tab you can search for any 

keyword whatsoever.  In the Results and Scatter Plot tabs, Find highlights features 

that match the search criteria. 
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Lab Book 

The Lab Book is a document that logs all file events that occur while GenePix Pro 

6.0 is running.  For example, the Lab Book automatically records whenever an 

image file, a settings file, or an array list file is opened or saved.  It is also a simple 

database:  double-clicking on an entry such as a settings or an image file opens it 

into GenePix Pro. 

Logged information from all image acquisition and analysis sessions can go to the 

same file, or alternatively, each session or experiment can have its own Lab Book.  

This allows you to keep track of your files during the course of a series of experiments. 

Like the Results spreadsheet, the columns in the Lab Book can be re-ordered by 

dragging and dropping their heading tabs. 

The Lab Book is saved as a binary file with a *.gpl extension, and its contents can 

be copied to the Windows Clipboard.  The Lab Book is automatically saved each 

time a new entry is made. 

Calibrate System 

The GenePix Pro system calibration procedure matches your scanner’s response to 

benchmark performance levels established at the factory. n ideal scanner.  Given the 

same scanner settings (i.e., PMT Gain and Laser Power if available), any calibrated 

scanners produce the same output from the same samples.  System calibration 

corrects for variations among scanners, and for slow variations that are inherent to 

all lasers and PMTs over the lifetime of the components.  GenePix Pro logs scanner 

performance in the Hardware Diagnostics Report every two hours during operation. 

The calibration procedure produces calibration constants that are used to adjust the 

voltage across each PMT.  For a calibration constant of 1.0, the range of the gain is 

100 to 1000.  Because calibration constants differ among scanners, the range of 

PMT Gain in the Hardware Settings dialog box may differ slightly among scanners 

(as this is an absolute scale).  The range may also change over a scanner’s lifetime 

as the calibration constant changes.   

To calibrate your scanner: 
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!# Click the Hardware Diagnostics button on the right-hand side of the 

GenePix Pro main window. 

!# Click the Calibrate System button. 

!# Check both the laser check boxes to calibrate both wavelengths. 

!# Click the Start button, and the wizard guides you through the rest of the 

procedure. 

To match the signal output from multiple scanners: 

!# Repeat the process above using the same calibration standard for all scanners.  

!# After calibration, setting each scanner to the same PMT gain will produce 

the same signal output from a given sample. 

Using Two Scanners 

You can connect to two different scanners from two different computers, or from 

the same computer.  

To connect to two scanners from the same computer (not at the same time): 

!# Create a GenePix Pro shortcut for each scanner (in the Axon Laboratory 

group of your Windows Start menu, or on the Windows desktop).  If your 

GenePix Pro software is installed in C:\Axon\GenePixPro4, then the two 

shortcuts would have the following targets: 

 C:\Axon\GenePixPro4 /Device1 

 C:\Axon\GenePixPro4 /Device2 

The identities of devices one and two depend on their SCSI order.  Double-

clicking on the Device1 shortcut attaches the software to scanner 1, while 

double-clicking on the Device2 shortcut attaches the software to scanner 2. 

Feedback 

Axon Instruments / Molecular Devices welcomes feedback on all its products.  

There is a Web page devoted exclusively to comments and suggestions on how to 
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improve GenePix Pro.  If your computer is networked, press the Feedback button to 

open a page on the Axon Instruments / Molecular Devices web site, from where 

you can send a message to Molecular Devices, or ask a question about GenePix 

Pro. 

 

 

 

Summary 
This is the end of the tutorial.  We hope that you enjoy using GenePix Pro 6.0.  

Axon Instruments / Molecular Devices has put every effort into designing and 

constructing an application that will work with you to get your array tasks done 

efficiently. 

Remember to refer to the on-line Help and the rest of the User’s Guide if you have 

any further questions about using GenePix Pro.  If you encounter a problem that 

you can’t solve, don’t hesitate to contact Technical Support.
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Appendix A 
 

Installing A Network Key 

Network License Key and NetHASP License Manager  
A network hardware protection key is a single device that provides security 

authorization for multiple-site license software, avoiding the inconvenience of 

having to install individual keys for each computer on the network.  After attaching 

the actual physical network key to one computer on the network, you also need to 

install the NetHASP License Manager and device drivers on the same computer.  

This computer is then referred to as the NetHASP server.  The NetHASP License 

Manager and HASP Monitor software provide centralized control and reporting of 

license and user information within the network.   

This Appendix has instructions for how to install the key and the License Manager 

and Monitor software.  If your multi-site license Axon software came with a 

bundled computer, then that computer will already have been configured as the 

NetHASP server.  If you wish to use another computer as the NetHASP server, 

simply uninstall the License Manager from the current server, then follow the 

installation procedure on the next page. 
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Installing the Network Key 

If you have purchased a multi-site license for your Axon software, you will be 

provided with a network key that you need to install to access the full functionality 

of the software.  The network key is a small USB device that can be attached to any 

computer on the network that has a free USB port, with the following conditions: 

!# The chosen machine must support USB:  for instance, the Windows NT 

operating system does not support USB devices, and so you cannot install 

the network key on a computer running Windows NT.  Dual-boot machines 

are not recommended.  

!# The chosen computer should ideally be one that is always switched on and 

rarely rebooted, for example:  a Mail, Print or other software server. 

Like any USB device, the network key may be ‘piggybacked’; in particular, if you 

use two or more Axon software products on your network, each with its own multi-

site license and network key, you can install all the network keys on the same 

computer.  This is convenient for centralized management of license and user 

information. 

To install the network key, simply attach it to a free USB port on the chosen 

computer. 

Installing NetHASP License Manager (Windows 2000 & Windows XP) 

After attaching the network key, you need to install the NetHASP License Manager 

and NetHASP device drivers on the same computer.   

A copy of the NetHASP License Manager software is provided with the installation 

CD-ROM for your Axon software.  To install NetHASP License Manager and 

device drivers: 

!# Close all programs and restart your computer. 

!# Insert the installation CD-ROM into your computer’s CD drive. 
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!# Open the My Computer icon on the desktop to display a list of your 

computer’s drives, and double-click the icon corresponding to the CD drive 

(frequently E:). 

!# Open the Network Key folder, and double-click lmsetup.exe to start the 

install process. 

!# The InstallShield program will ask whether you want to install the 

NetHASP software, and then prompt you to close any active NetHASP 

License Manager processes before continuing1select Yes in both dialogs. 

!# The installer then reports previous installation and version 

information1select Next. 

!# The installer then prompts for what type of installation you want:  Typical, 

Service, or Custom1select Service, then Next. 

!# You are now prompted for the name of the directory to which the NetHASP 

License Manager software will be installed; you can choose a location 

yourself, or leave the destination default (C:\Program Files\Aladdin\ 

NetHASP LM).  Select Next. 

!# Select Yes in the dialog that appears confirming the creation of the 

destination directory. 

!# The installer then prompts for the name of the Program Folder in which the 

NetHASP icons will be created1you can choose a new folder yourself, or 

leave the folder name default (NetHASP License Manager).  Select Next. 

!# The installer then displays the current installation configuration, and you 

are prompted to confirm or change as desired.  If the settings are correct, 

select Next, otherwise step Back to change the details. 

!# Select OK in the dialog that appears reporting that the NetHASP License 

Manager has been installed successfully. 

!# The installer then automatically proceeds to install the NetHASP Device 

Driver1select Yes to continue. 
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!# Select OK in the dialog that appears reporting that the driver was installed 

successfully. 

!# You are then prompted to start the installed NetHASP License Manager 

service1select Yes. 

!# Select OK in the dialog that appears reporting that NetHASP License 

Manager was started successfully. 

!# Select Finish to exit from the install program. 

The NetHASP License Manager and NetHASP device drivers are now installed, 

and the License Manager service is running. 

Installing HASP Monitor Program (Windows 2000 & Windows XP) 

After installing the network key, the License Manager and drivers, you may want to 

install the Aladdin HASP Monitor software on the NetHASP server.  The HASP 

Monitor is used to track and report usage information for the licenses operating on 

the network.   

A copy of the Aladdin HASP Monitor software is provided with the installation 

CD-ROM for your Axon software.  To install Monitor: 

!# Close all programs. 

!# Insert the installation CD-ROM into your computer’s CD drive. 

!# Open the My Computer icon on the desktop to display a list of your 

computer’s drives, and double-click the icon corresponding to the CD drive 

(frequently E:). 

!# Navigate to the \Hasp Monitor\install\ directory, and double-click the 

aksmon32 icon to start the install process. 

!# The install program starts, and prompts you to exit all Windows 

programs1select Next to continue. 
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!# You are now prompted for the name of the directory to which the Monitor 

software will be installed; you can choose a location yourself, or leave the 

destination default (C:\Program Files\Aladdin\Monitor).  Select Next. 

!# The installer then asks whether you want to create backup copies of files 

that are replaced by the installation process, and prompts for a backup file 

destination directory.  Select the Yes button (enable backup creation), 

choose a destination, then select Next. 

!# The installer then prompts you to either continue with the current 

installation setup (select Next), or step Back to change the current 

configuration. 

!# The installer should report that the Monitor software has been successfully 

installed1select Finish to exit from the install program. 

The Aladdin HASP Monitor software is now installed.  Now when GenePix Pro is 

installed on any computer on the network, it will automatically recognize the 

network license. 
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Technical Assistance 

If you need help to resolve a problem, there are several ways to contact Axon 

Instruments / Molecular Devices: 

World Wide Web 

www.axon.com

Phone 

1 (800) 635-5577 

Fax  

+1 (510) 675-6300 

E-mail 

axontech@axon.com 

Questions? 

See Axon's Knowledge Base:  http://support.axon.com 
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Customer License Agreement 

Customer License Agreement for Single User of GenePix Pro 6.0. 
This software is licensed by Molecular Devices, Corp. ("MOLECULAR DEVICES ") to you for use 

on the terms set forth below.  By opening the sealed software package, and/or by using the software, 

you agree to be bound by the terms of this agreement. 

MOLECULAR DEVICES hereby agrees to grant you a non-exclusive license to use the enclosed 

MOLECULAR DEVICES software (the "SOFTWARE") subject to the terms and restrictions set forth 

in this License Agreement. 

Copyright 
The SOFTWARE and its documentation are owned by MOLECULAR DEVICES and are protected 

by United States copyright laws and international treaty provisions.  This SOFTWARE may not be 

copied for resale or for bundling with other products without prior written permission from 

MOLECULAR DEVICES. 

Restrictions on Use and Transfer 
You may not reverse engineer, decompile, disassemble, or create derivative works from the 

SOFTWARE. 

Export of Software 
You agree not to export the SOFTWARE in violation of any United States statute or regulation. 

Ownership of Software and Media (CD-ROM) 
You own the media (CD-ROM) on which the SOFTWARE is recorded, but MOLECULAR 

DEVICES owns the SOFTWARE and all copies of the SOFTWARE. 

Product Improvements 
MOLECULAR DEVICES reserves the right to make corrections or improvements to the SOFTWARE 

and its documentation and to the related media at any time without notice, and with no responsibility 

to provide these changes to purchasers of earlier versions of such products. 
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Term 
This license is effective until terminated.  You may terminate it by destroying the SOFTWARE and its 

documentation and all copies thereof.  This License will also terminate if you fail to comply with any 

term or condition of this Agreement.  You agree upon such termination to destroy all copies of the 

SOFTWARE and its documentation. 

Limited Warranty and Disclaimer of Liability 
MOLECULAR DEVICES warrants that the media on which the SOFTWARE is recorded and the 

documentation provided with the SOFTWARE are free from defects in materials and workmanship 

under normal use.  For 90 days from the date of receipt, MOLECULAR DEVICES will repair or 

replace without cost to you any defective products returned to the factory properly packaged with 

transportation charges prepaid.  MOLECULAR DEVICES will pay for the return of the product to 

you, but if the return shipment is to a location outside the United States, you will be responsible for 

paying all duties and taxes.   

Before returning defective products to the factory, you must contact MOLECULAR DEVICES to 

obtain a Return Merchandise Authorization (RMA) number and shipping instructions.  Failure to do so 

will cause long delays and additional expense to you.   

MOLECULAR DEVICES has no control over your use of the SOFTWARE.  Therefore, 

MOLECULAR DEVICES does not, and cannot, warrant the results or performance that may be 

obtained by its use.  The entire risk as to the results and performance of the SOFTWARE is assumed 

by you.  Should the SOFTWARE or its documentation prove defective, you assume the entire cost of 

all necessary servicing, repair or correction.  Neither MOLECULAR DEVICES nor anyone else who 

has been involved in the creation, production, or delivery of this SOFTWARE and its documentation 

shall be liable for any direct, indirect, consequential, or incidental damages arising out of the use or 

inability to use such products, even if MOLECULAR DEVICES has been advised of the possibility of 

such damages or claim.   

This warranty is in lieu of all other warranties, expressed or implied.  Some states do not allow the 

exclusion or limitation of implied warranties or liability for incidental or consequential damages, so 

the above limitations or exclusions may not apply to you. 

U.S. Government Restricted Rights 
The SOFTWARE and its documentation are provided with RESTRICTED RIGHTS.  Use, duplication 

or disclosure by the U.S. Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of 

The Rights in Technical Data and Computer Software clause at DFARS 252.227-7013, or 

subparagraphs (c)(1) and (2) of the Commercial Computer Software -Restricted Rights at 48 CFR 

52.227-19, or clause 18-52.227-86(d) of the NASA Supplement to the FAR, as applicable.  

Manufacturer is Molecular Devices Corp., 1311 Orleans Drive, Sunnyvale, CA, 94089-1136, USA. 

Governing Body 
This Agreement is governed by the laws of the State of California.
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Licensing Notice 

Axon Instruments / Molecular Devices is not licensed under any patents owned by 

Oxford Gene Technology Limited (“OGT”), covering oligonucleotide arrays and 

methods of using them to analyze polynucleotides. The purchase of Axon 

Instruments / Molecular Devices products does not convey any license under any of 

OGT’s patent rights, including any right to make or use oligonucleotide arrays 

under OGT’s patents. 

Customers may use Axon Instrument / Molecular Devices products to analyze 

oligonucleotide arrays according to OGT’s patented methods if those arrays have 

either been purchased from OGT’s licensed suppliers, or have been made by the 

customer under a license from OGT. 

Please contact OGT to enquire about a license under OGT’s patents at 

licensing@ogt.co.uk <mailto:licensing@ogt.co.uk>. 
USE OF THIS INSTRUMENT WITH MICROARRAYS MAY REQUIRE A LICENSE 

FROM ONE OR MORE THIRD PARTIES THAT HAVE PATENTS RELEVANT TO 

SUCH USE.  AXON INSTRUMENTS / MOLECULAR DEVICES DOES NOT 

SUGGEST OR PROMOTE THE USE OF THIS INSTRUMENT IN A MANNER THAT 

INFRINGES ON THE PATENT RIGHTS OF A THIRD PARTY.  YOU ARE 

ENCOURAGED TO EVALUATE WHETHER A LICENSE IS REQUIRED FOR YOUR 

SPECIFIC APPLICATION OF THIS INSTRUMENT.  COMPANIES THAT HAVE 

INTELLECTUAL PROPERTY RIGHTS IN THE POTENTIAL FIELD OF 

APPLICATION OF THIS INSTRUMENT INCLUDE WITHOUT LIMITATION, 

AFFYMETRIX, INC. (“AFFYMETRIX”), AGILENT, AND OXFORD GENE 

Licensing Notice 



100  !  Licensing Notice 

TECHNOLOGY.  THIS INSTRUMENT HAS NOT BEEN LICENSED OR APPROVED 

FOR DIAGNOSTIC APPLICATIONS. 

THE USE OF THIS INSTRUMENT IN CONNECTION WITH MICROARRAYS MAY 

BE WITHIN THE SCOPE OF PATENTS HELD BY AFFYMETRIX.  TO THE EXTENT 

THAT AFFYMETRIX PATENT RIGHTS ENCOMPASS THIS INSTRUMENT OR ITS 

USE, AFFYMETRIX HAS GRANTED A LIMITED PATENT LICENSE FOR 

RESEARCH USE ONLY AND NOT FOR USE IN DIAGNOSTIC PROCEDURES. SUCH 

LICENSE, IF APPLICABLE, IS LIMITED TO USE OF THIS INSTRUMENT WITH 

SPOTTED MICROARRAYS SEPARATELY LICENSED BY AFFYMETRIX. NO 

LICENSE IS CONVEYED, BY IMPLICATION, ESTOPPEL OR OTHERWISE, TO USE 

THIS INSTRUMENT WITH MICROARRAYS MADE USING IN SITU OR 

PHOTOLITHOGRAPHIC SYNTHESIS. NO OTHER LICENSE IS CONVEYED, BY 

IMPLICATION, ESTOPPEL OR OTHERWISE, UNDER ANY AFFYMETRIX PATENT 

OR OTHER INTELLECTUAL PROPERTY RIGHT. 

This instrument is licensed by Affymetrix under the following patents:  U.S. Patent 

Nos. 5,578,832; 5,631,734; 5,834,758; 5,936,324; 5,981,956; 6,025,601; 6,141,096; 

6,171,793; 6,185,030; 6,201,639; 6,207,960; 6,218,803; 6,225,625; 6,252,236; 

6,262,838; 6,335,824; 6,403,320; 6,403,957, 6,407,858; 6,472,671; 6,490,533; 

6,545,264; 6,597,000; 6,643,015; and 6,650,411.
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Array List 

An array list is a file (*.gal) that contains block and 
substance information for the array, which is supplied 
by the slide manufacturer.  Create array lists from plain 
text files with the Array List Generator.  The Load Array 
List command creates an array of blocks with 
dimensions based on the Array List, and with each 
feature-indicator named according to the substance 
names in the Array List.  These names are then used in 
the various Feature Viewers, the Pixel Plot dialog box 
and the Results tab. 

Block 

A collection of feature-indicators drawn on an image in 
GenePix Pro.  The collection of all blocks on a slide is 
called an array, and a subset of identical groups of 
blocks is called a subarray. 

Boolean Query 

A Boolean Query in GenePix Pro is a statement in the 
Flag Features dialog box expressed in Boolean logic, 
i.e., atomic sentences connected by the operators 
AND, OR and NOT. 

Feature 

A feature is a spot on an array.  The collection of such 
features is called an array.  GenePix Pro assigns 
feature-indicators to features in order to analyze each 
feature separately. 

Feature-indicator 

A feature-indicator is a circular region defined on an 
image within which GenePix Pro calculates the pixel 
intensity and feature intensity of a feature on the array.  

A portion of the image outside the feature-indicator is 
used to calculate the feature background intensity. 

Feature Background Intensity 

The feature background intensity of a feature at a 
wavelength is the median intensity of the set of 
background pixels defined for that feature.  The 
background pixels include all of the pixels within a 
circular region that surround the feature of interest.  
The circular region has a diameter of three times the 
diameter of the current feature-indicator.  All pixels that 
are contained within a neighboring feature-indicator, or 
the feature-indicator of interest, are excluded.  Using 
the median, rather than the mean, of background pixel 
intensities significantly reduces the effect of spurious 
pixels significantly contributing to the background. 

Feature Intensity 

The feature intensity is defined as the median or mean 
of all of the pixel intensities in a given feature-indicator. 

Feature Pixel 

A feature pixel is a pixel that falls within (in a 
technically well-defined sense) a feature-indicator.  
Pixel intensities of feature pixels at different 
wavelengths are used to calculate various derived 
quantities, such as feature intensities. 

Flag 

Added to a feature-indicator to highlight some feature.  
In Feature mode, you can Flag features as ‘Good’ or 
‘Bad’.  Features flagged ‘Good’ are marked with a 
circle, and features flagged ‘Bad’ are marked with a 
cross.  Features used to calculate the normalization 
factor are marked with a square.  Flags are exported to 
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the Results window.  When exporting GenePix 
numerical data to spreadsheet programs like Microsoft 
Excel, Flags appear as ‘100’ (good), ‘–100’ (bad), ‘0’ 
(not included in normalization), or ‘1’ (included in 
normalization).   

If a feature cannot be found during an Auto Align 
Blocks, it is flagged Not Found (numerically reported 
as –50).  If an array list is missing a description of a 
particular feature, the feature is flagged Absent 
(numerically reported as –75).  

Nudge 

To move a single, or group, of feature-indicators within 
a block.  Do this in Feature mode by selecting a 
feature-indicator and then moving it with the arrow 
keys. 

Pixel Intensity 

The raw intensity of a pixel on a GenePix Pro single-
wavelength or ratio image, falling in a range from 0 to 
65535.  Pixel intensity (P) is reported in the Feature 
Viewer, and is one of the quantities exported to the 
Results window during an analysis. 

Photomultiplier tube (PMT) 

An optical device that detects photons and ultimately 
generates an electrical current that is proportional to 
the number of detected photons.  The PMTs in the 
GenePix scanner are used to detect the photons that 
are emitted from the laser-excited fluorophores on the 
array. 

Ratio Image 

Any ratio image in GenePix Pro is an RGB (Red-Green-
Blue) overlay image.  Ratio images exported as JPEG 
or TIFF files are 24-bit RGB color. 

Saturation 

Saturation refers to the overloading of the 
photodetection circuitry.  Saturation can be reduced by 
reducing the amount of light that is reaching the PMTs, 
which is done by reducing the amount of incident laser 
light.  In practice, this is accomplished by reducing the 
gain of the PMT.  Saturating pixels in GenePix Pro are 
shown as white pixels in the raw wavelength images. 
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Feature Viewer, 8, 102 Find, 84 Align Blocks, 58 
Pixel Plot, 8, 23 Flag, 27, 62, 101 Analysis Array, 54 

Data Scan, 14 Flag Features, 70 Analysis Only Mode, 36 
Data Types, 66 Focusing, 44 Analyze, 65 
Dongle, 3 Four-Color Mode, 48 Array List, 8, 54, 66, 101 
Dynamic Range, 40 Full Scale, 52 Array List Generator, 12, 57, 101 
  ATF, 31 
Feature, 8, 11, 54, 101 GAL, 12, 31, 54, 56, 57, 101 Autoscale Display Settings, 52 
Feature Intensity, 101 GenePix Pro  
Feature Mode, 61 Analysis Only mode, 36 Background Intensity, 25, 101 
Feature Viewer, 8, 53, 102 Dongle, 3 Background Subtraction, 65 

Glossary, 101 Feature-Indicator, 54, 101 Barcode Reading, 14 
Flagging, 62 GPL, 32, 85 Block, 8, 54, 101 
Manipulating, 61 GPR, 32 Aligning, 8, 22 
Moving, 61 GPS, 32, 44 Creating, 54, 57 
Not Found, 22 Quick Zooms, 60 Group Rows, 66 
Orange-Packing, 56 Resizing, 60  
Resizing, 61 Saving Position, 64 Hardware Spacing, 56 

Block Mode, 59 Focusing, 44 
File Formats, 31 

 Signal-to-Noise, 42 
ATF, 31 

Calibrate System, 85 Hardware Settings, 40 GAL, 31, 54, 57 
Coefficient of Determination, 25 Histogram Tab, 80 GPL, 32, 85 
Color Mode, 47  GPR, 32 
Cy3, Cy5, 16 Image GPS, 32 
 GPS, 32, 44 Analysis, 47 

JPG, 46, 102 Colors, 51 Data 
TIF, 45, 102 Compression, 33 Analyzing, 65 

Display, 14 File Names, 46 Exporting, 74 
Display During Scanning, 39 Filter Selection, 43 Data Preview, 8 
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Ratio, 39 
Register, 49 
RGB, 102 

Installation, 1 
Computer Requirements, 1 

 

JPG, 32, 33, 46, 102 

 

Lab Book, 9, 32, 85 

Lasers 
Adjusting Power, 43 

Line-Averaging, 42 

Linkage, 67 

Load Array List, 55 

Lock Settings, 64 

 

Mean, 17, 23, 24, 25, 26, 101 

Median, 17, 23, 24, 25, 26, 101 

Multiple Scanners, 86 

Multiple Users, 84 

 

Navigation Window, 52 

Normalization, 28, 69 

Nudge, 102 

 

On-Line Help, 36 

Open Settings, 44 

 

Photo-Multiplier Tube, 40, 102 
Settings, 81 

Pixel Intensity, 102 

Pixel Plot, 8, 23, 79 

Pixel-by-Pixel Ratios, 23, 24, 25 

Preview Scan, 14 

Pseudocolor, 7 

 

Quality Factors, 26 

 

Ratio 
Computation Of, 23 
Display of, 102 
Formulation, 50 
Image, 39, 102 
Log, 26 
Pixel-by-Pixel, 23, 24, 25 

Register Images, 49 

Replicate Mode, 56 

Report Tab, 77, 84 

Results File, 32 

Results Tab, 32, 66, 76 

RGB Image, 15, 102 

 

Saturation, 40, 102 

Scan Area, 7 

Scatter Plot tab, 75 

Scatter Plot Tab, 8 

Scripting, 77 

Settings File, 32, 44 

Signal-to-Noise, 26, 42 

Software 
Analysis Only mode, 36 
Exporting Data, 74 
File Saving, 45 

Flags, 27 
Hardware Settings, 40 
Histogram Tab, 80 
Image Display, 51 
Installation, 1 
Lab Book Tab, 85 
Results Tab, 66 

Spotted Substance, 16 

Standard Deviation, 20 

Subarray, 101 

Substance 
Spotted, 16 
Test, 16 

 

Technical Support, 9, 95 

Test Substance, 16 

TIF, 33, 45, 102 

Troubleshooting, 5 

 

User Identification, 84 

Using Two Scanners, 86 

 

Web Address, 58 

Web Integration, 8, 68 

Well Converter, 58 

Workflow, 83 

 

Zoom Area, 60 

Zoom Mode, 52 

Zoom Undo, 52 
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